TIME MANAGEMENT

Managing Time with
UNIT-6 Outlook

Learning Outcomes

By the end of this unit the learner will be able to:

Recognize the obstacles that prevent us from effectively managing our time
Use a planner

Write everything you need to remember in your planner

Use a to-do book

Use the viewing tools available in Outlook 2007

Group different types of items in Outlook 2007

Use Auto Preview in Outlook 2007
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Unit 6

Managing Time with Outlook

The Power of Change
It takes time to make time work for you. If you are truly going to make any difference in your life because of today,
you have to be prepared to make some changes.

It doesn’t matter if you love them or hate them; computers are here to stay. When you combine effective time
management techniques with the proper use of a computer, you are well on the way to getting yourself organized.
In this book, we will combine time management strategies and Microsoft Office Outlook 2007 together and help
you stay focused, organized, and productive.

There is a very expensive weight loss clinic in New York State that won't take people who aren’t prepared to make
small changes in their life. They arrive at the clinic expecting to get a diet that will make them thinner. Instead, they
are asked to go home and fill out a journal of all the changes they can make in their lives in a week. They may want
to drive to work a different way or sit at a different place when they sit down to a meal. They may try sleeping on
the other side of the bed or making little changes in their early morning routine.

When people go back to the clinic at the end of the week, staff members evaluate the changes the person was able
to make. If these changes aren’t successful, they are not accepted into the program. They are told, “If you can’t
change these small things, how will you make the major changes required to learn new ways of thinking about
food?”

Are you truly ready to try making a few changes after today? If so, this book will teach you how to develop good
time management habits and demonstrate how to apply these skills using Microsoft Outlook 2007.

What do you believe are your top three priorities/objectives in your position?

What do you believe are the top three obstacles to working on your priorities or meeting your
objectives as the moment?

On a scale of one to ten, how organized would you rate yourself?

What are the top three things you think you must do in order to be more organized?

What would you do with any additional time if you found a way to give it to yourself?
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What do you believe are your typical strategies for managing your work and your time? Most of us try one of the following
techniques when we get snowed under:

Work harder
Work faster
Get organized

Have you ever tried these three techniques to get back on track? How successful were they in

helping you?

We all have the power of choice. Your organizational style is a result of the choices you make on a minute by
minute basis.

Can you give some examples of how choice affects the way you work?

What is the one activity that you know if you did superbly well and consistently would have
significant positive results in your personal life?

If you know these things would make such a significant difference, why are you not doing them
now?
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Case Study: Another Day at the Office

It was 7:20 a.m. when Myron arrived at the office. He was early because he wanted to clear the backlog of work
that had been piling up on his desk. He turned on the lights and started to go through yesterday's e-mail. As he
read the first message, he realized he couldn't deal with it until a colleague arrived. He set it aside and went to the
next. This item had potential application to a project he was working on, so he walked down the hall to the printer
and made a copy for his personal use.

As he continued reading his e-mail he came across a journal article of particular interest and become engrossed in
it. As he looked up, he was startled to find that others were arriving and it was nearly 9:00.

He ignored the rest of his e-mail, moved a pile of papers to a corner of his desk and reached for a project file due
tomorrow with at least two days of work yet to be completed. As he opened the file, Bill and Claire stopped by and
invited him to join them for coffee. Myron decided he could spare ten minutes. Bill and Claire were both anxious to
share the details of a play they attended last night. Before Myron realized it, thirty minutes had passed and he
hurried back to his office.

As Myron entered his office, the phone rang. It was Mr. Wilson, his manager. There was a meeting scheduled at
10:00. Could Myron sit in for him? There was something to be discussed that the department should know about.
Myron looked at his watch. There wasn't enough time to get started on the project so he pushed the file aside and
vowed to start it immediately after lunch.

The afternoon wasn't any better. A few visitors, a few phone calls, a couple of letters, and the day was over.
Nothing had been accomplished on the project that was due tomorrow. As he stuffed papers into his briefcase, he
wondered how Bill and Claire were able to attend plays during the evening.

Did he make good use of his best time of day?

Did he work on his high priority items?

Did he have a problem saying no?

Did he complete the tasks he started?

Did he understand his problems?

What would you recommend for Myron?
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Planning Tools

Guidedlinesfor Efficient Planning

Y ou can save yourself an hour aday by getting organized.

It isimportant to identify and operate within two time horizons: short and long term. Anticipating events allows you to
get things done in the short term which contribute to achieving long-term objectives.

An up-to-date master calendar can be your most helpful planning tool. However, detailed project plans should be
developed before you make entries on your master calendar.

When things begin to get hectic, a"Things To Do Today" list helps focus attention on the highest priority items.
Action planning worksheets, milestone charts, and PERT diagrams are excellent planning aids when properly used.
Planning contact with colleagues and staff will help minimize disruptions. Keep afile for each person you meet with on
aregular basis, with items to be discussed.

The most effective approaches to planning are those tailored to meet individual needs. Concepts, procedures, and
worksheets should be modified to fit individual circumstances.

Experts say nothing should be attempted without prior planning, but there must be flexibility. Remember Murphy’s
Law: If something can go wrong, it will.

Five Point Planning Check

For every plan you make, cover all these points:
- What
Where
When
How
Who

Five Minutes Beforethe Hour

If you have a desk or other surface that is cluttered, set aside five minutes at the end of each hour to clear off one
small part of it. This goes for your electronic files too! At the end of your five minute session, set a timer for fifty-
five minutes so you’ll remember the next five minute period.

What can you get done in only five minutes? Try it - you’ll be surprised. At the end of two weeks you’ll see a vast
improvement. This example of instant success will bring a feeling of genuine satisfaction.

Using a Planner

A planner can be your best friend if you know what you want the planner to do and you know how to use it
effectively. Let’s take a look at some aspects and characteristics you should look for when using a planner.

What are your options when choosing a planner?
- A calendar. Like cockroaches, calendars have stood the test of time.
A to-do list. Someone once said, “Document what you do. Someone is sure to ask.”
A binder, with room for information, information, information.
A computer-aided planner with time management software, such as Microsoft Office Outlook 2007.
Thedigital alternative like a handheld organizer, smart phone, or Pocket PC: they can even talk to you!

When choosing your personal planning tool you should ask yourself these questions:
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What do you want it to do?
How big do you want it to be?
How much do you want to spend?

Do you currently use a planner?

What are the essential things to look for when you purchase a planner?

What are the key strategies for using a planner successfully?

Many types of planners can work, depending on the needs of the individual. Some people want a calendar, a week
at a glance, a space for a to-do list, and room for notes. Others want something so small it fits in a breast pocket. As
for strategies, there will be several suggestions about how people use their planner, but the most important thing
is to use them.

How do you remember to call Jim next Wednesday? Noteit in your planner.

How do you remember to follow up with a client in six months? Note it in your planner.

How do you remember to start a project in six weeks time? Note it in your planner.

How do you remember not to schedule an out of town meeting for your parent’s 50th wedding anniversary? Note it in
your planner.

Once we begin using a planner, we sometimes have a tendency to only make note of meetings we must attend or
other activities that must be completed, without allotting the time required. For example, if you are attending a
meeting that will take up two hours of your time, block out that two hours. Then you have a more realistic sense of
how much time has been used and how much time you have remaining to use. Anything over 30 minutes should
have time booked.

We will explore how you can transfer information from your paper planner to Outlook 2007 (and vice versa) in
Module Three. If you learn to effectively use your paper planner in parallel with Outlook 2007, then you will be well
prepared to tackle the things you need to get done.

The To-Do Book

A to-do book is one of the simplest, most effective time management tools out there. It’s easy to use, easy to carry
around, and easy to update and customize. To start, decide how you want to record your tasks. We recommend an
elementary school style scribbler, but you can also use Tasks or Notes in Outlook 2007 or a regular notepad —
whatever works for you.

Next, make sure you write down the date on any important piece of paper. If you're using a blank page in your
planner or To-Do book, write the date at the top of the page. Then, make a master list of everything you have to do
for home or work. (We suggest that you make different lists for each.) Now, take out a highlighter and highlight the
top three things that you want to accomplish. During the day, every time you complete an item, cross it off.
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Nothing feels better than crossing off your list items one at a time! This seemingly simple action is an excellent way
to keep your motivation high throughout the day.

At the end of the day, start a new page. Write the next day’s date on it. Then, transfer any uncompleted items to
that next page and add all the things you need to do the next day. Highlight the top two items that you want to get
done. When you start work the next morning, add any items that have come up, and highlight your third top
priority.

Some people find that master list really intimidating because you are seeing ALL of your tasks at once. A modified
approach is to lay out your week like this:

Monday Tuesday Wednesday Thursday Friday

List your tasks for each day in each column. (For the sake of simplicity, let’s say today’s Sunday, and you’re planning
out your week.) At the end of Monday, you’ll transfer any uncompleted items to Tuesday’s column and add any
new tasks. At the end of the week, you’ll transfer any uncompleted items to next week’s list.

This approach can also be used for teams. Take a whiteboard and turn it into a chart like the one above. Then write
each team member’s tasks in a different color using sticky notes or markers. (Sticky notes are useful because they
allow you to easily move tasks around, rather than re-writing them.)

Whichever methods you end up using, make sure that you stick to them! Don’t rely 100% on your memory if you
need to remember important pieces of information. Write that information down as soon as you have the chance,
and make sure you write that information in the correct place! Even if you do remember the information, the
worst that can happen is that you’ll be reminded again.

Let’s assume you are using Outlook 2007 to record important information. Now let’s see how you can use the view
and sort commands to help organize your information.
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Using Outlook’s Viewing Tools
Now that you have an understanding that you should record the things you have to do, it’s time to learn how you
can use Outlook 2007 to do so much more for you than just send and receive e-mails.

Open Microsoft Office Outlook 2007 and open your Inbox folder.

Using Arrange By
Let’s discuss how to use the View menu to arrange items within a folder.

Click the View menu and point to the Arrange By submenu.

ey
Arrange By 3 ql Date
Current Wiew [% b o Conwersation
-11 AutoPreyiew Eram
Expand/Collapse Graups » Ta
Mavigation Pane [ Categories
To-Do Bar ] Flag: tart Date
Reading Fane [ Flag: Due Date
Reminders YWindow size
Toolbars = subject
v status Bar Tipe
A Refiesh EEg Attachments
E-mail Account
Importance
Custom..,
Tl Showy in Groups

You can click any of the options to group your items by that category.
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Look at the items in our sample Inbox.

|l3 Inh_ox-_ Search Imbo; § o v| ¥ ‘
Arranged By: Date Mewest on top w| -
2t - i
CooUnt lef \\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\ B
= Susan Harris 271372007
Upcoming Staff Party
= Micrasoft 1041942006
Canadian Techiet Flash: Special Events Edition - Launch 2007
(=1 PoweerPoint User 6/21/2006 8
Flease review ‘Lesson 4,17 o -

Here our items are arranged by the default category (date). This is a very useful view, but you may want to arrange
items in different ways. If you choose to arrange the items by the sender, the items will be arranged like this:

|IE Inbox Search Imbo: p v| A ‘
Arranged By: From Aontop | a
= Microsoft

=i Microsoft 10/19/2006

Canadian Techhet Flash: Special Events Edition - Launch 2007

=l PawerPaint User

(<] PowerPoint User 6212006 \a
Please review 'Lesson 4,1 i

I=] susan Hatris

e e L A e e e e b e b B o b e e e e S b S o b B A S A S A S b s .—‘.—‘-.—‘-.—‘-
&l Eumﬁarﬁa; ﬁﬂ@ﬁ&?
o
 Accounting Report
(=i Susan Harris 21372007

Upcoming Staff Parby

Try arranging the items in your Inbox now using the Arrange By submenu
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As a shortcut, you can click the words “Arranged By” at the top of the folder to choose a different
arrangement.

You can also click the words “<field> on top” to change the sort order.

|[E Inbox Search Inbioy Pz ‘
Arranged By From |~JS — Aontop |
14 s
= Microsoft Canversation
o Microsoft v From 1041972006
Canadian TechMet Fig o Launich 2007
= powerPaint User Categories
= PowerPaoint Lset Flag: Start Date B/21/2006 &
Please review 'Lesson Flag: Diue Diate i
[=] susan Harris size
gk T ; T "y
i SusanHartis SHicet EEETE TR
_Accounting Report Type ;
=4 susan Harris — 2/13/2007
Upcoming 5taff Party
E-ruail Account
Importance
Custom..,
!_. Show in Groups
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About Groups

In the image on the previous page, you can see how items appear in various groups (Microsoft, PowerPoint User,
and Susan Harris). You can click the title of a group to select all the messages in it, making moving and deleting
items much easier.

Click a group title in your Inbox now to select all messages under that title.

Mail « || Inbox SerrehInky D~|x
Favwile Fuliders % | Aranged By From (Aantap
Lirag Your Fayarts Folders e
1 picrusurt
Mail Folders ol 5
= Microsoft 13/18/2006
A A1 man me ms il Canadian Techhet Flasar Saecal Bverts Edition - Laurica 2007
= €6 Foundatian Level O _
= Egﬂﬁtﬂiﬁ&mi FlwwerPoitl Usxer
L Drafts % 1 PoweerPoint User 322006 ]
L_;] Inbox Fease review ‘Lesson 4.1 o
[ g Junk E-mait (1] e e e
(5 outbax EJ’EWHJW
3 RS Feed m——
? S5 ~-1 Sasan Harriz 2/13/2007
;;j Seqt Ttermns P '[-" qReport D
[ Searrh Frlders — Q: Tp - ————
- Sasan Hartiz _ 2132007

You can toggle groups on and off under the Arrange By menu. Click View = Arrange By = Show in Groups.

Select a folder that has lots of items in it, such as Inbox or Deleted Items, and then uncheck the
Show in Groups item shown in the image above. How has your view changed?
(We recommend you leave the Show in Groups option selected!)
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You will also find commands under the View menu to expand (show all the messages in) or collapse (hide all the
messages in) groups.

wiew | Go  Tools  Actions
Arrange By 3

Current Wiew ¥

i-:i ALtoPreyiew

Ez‘pandftnllﬁpse Grnup .b Collapse This Group

Mavigation Pane 3 Expand This Graup

To-Do Bar 3 Collapse Al Groups

Beading Pane 3 Expand &l Groups

Reminders YWindow . Always Showe Linread and Flagged Messages
Toolbars [

v Status Bar

Refresh FS

You can perform the same tasks using the plus and minus signs next to a group.

|[‘3 Inbox Search Inbiox pe v| ¥ I
Arranged By Frpfl'i‘ | & ontap 4 | £
Min:r'u:ns::nft

(=i Microsoft 10/19/2006

Canadian TechMet Flash: Special Events Edition - Launch 2007

= powerPaint User

(=1 PowerPoint User 621 2006 '3
Please review 'Lesson 4.1 o -

Susan Harris

This grouping feature is also available in the Tasks folder and in some views of the Contacts and Calendar folders.

Try expanding and collapsing some different groups now.
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Using Current View

The Current View submenu under the View menu offers a wide variety of view choices. These choices are pre-made
views that let you select a commonly-used view. (Note that this submenu can change depending on the folder you
are currently viewing.

ey
Atrange By F
Current Wiew v Business Cards

<l AutoPreview % Sddress Cards
Expand/Collapse Groups » Detailed Address Cards
Mavigation Pane 4 Phane List
To-Do Bar F By Categary
Reading Pane 3 Ew Company
Reminders Windiow By Location
Toalbars » | ¥ Outlook Data Files

w  Status Bar Customize Current Wiew..
Befresh EE Define Wigws,.,

Format Colummns...

Just click to apply the view that you want.

Experiment with some of these view options now.

About AutoPreview

The last command in the View menu that we will look at is AutoPreview. (This command is only available in the
Mail and Tasks folders.)

__'l‘f.f.?ﬁ'@r_'_'.J E.‘.:' Tools El'l‘_'un_s

Arrange By 3
Current Wiew 3

"—-:‘1 AutoPrewi e

Expand/Collapse tl’k\"nups 3

Enable this feature now.
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This feature will show the first few lines of the task or message right in the viewing pane.

|E3 Inbox |Search Inbo; P~y |
Arranged By: Date Mewrest on top | o

= oider

| | Susan Harris 2/13/2007
| Accounting Repart. |
Hi lames: ' .
Jusj:.‘-;'u-ﬁemjnder-th atIneed those figures by theend of the day today!
i Thanks, .
[=d Susan Harris 2372007
Upcoming Staff Party
Hi Sam,
Do wou hiawe an estimated date for the next staff function?
Thanks,
(=i Microsoft 1041942006
Canadian Techhet Flash: Special Events Edition - Launch 2007
Sign up for other newesletters
<http://go.microsoft.com/7linkid=5646444= | Unsubscribe
<httpif/go.microsoft.comy7linkid=5645445= | Update your profile
[=d PoweerPoint User 672172008
Flease review 'Lessorn 4,17 1] 13
Please rewiews the attached document. <end=

By default, the Reading Pane is turned on in Outlook 2007. This pane shows the contents of a selected item simply
by selecting the item. The AutoPreview feature is particularly useful if you keep the Reading Pane turned off.

To modify the way the Reading Pane is shown in Outlook 2007, click View and point to the Reading Pane submenu.
Then you can choose to put the pane on the right (default), the bottom of the screen, or turn the pane off.

Summary

Technologies come and go, and the nature of your work will likely change a lot over the course of your career.
However, one thing will remain the same for all of us: time. There are still sixty minutes every hour and twenty-four
hours in a day. Learning to make the most of the time you have is key to getting things done well and on time. You
have to be willing to take the time to change in order to drop the bad habits, control procrastination, and get things
done. In order to keep on top of the things you need to do in a day, it is important to get and stay organized and
make sure you have the tools you need to properly do your job.

Review Questions

How much time per day can you save if you get organized?
What three things do most people do when they get buried in too much work?

What is the most important thing you can do with a planner, no matter what type of planner you use?
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Name five ways that Outlook 2007 can arrange messages in your Inbox.

What does the AutoPreview command do?

Setting up Outlook

In this Module, we will learn how to:
Change the way Outlook 2007 alerts you regarding incoming mail and networking activity
Use and customize the Quick Access Toolbar
Customize existing toolbars and the menu bar
Create your own toolbars
Create your own menus

Changing Notification Options
In the last Module, we discovered some of the basic time management techniques to help you stay organized. We
also outlined how you can use the View menu in Outlook 2007 to quickly and easily sort through a folder full of e-
mail. This Module will focus on how you can personalize Outlook 2007 to fit your working style.

About the Notification Icon

To begin, open Microsoft Office Outlook 2007 and minimize the window.

When you open Outlook, you may see an Outlook icon in the tray next to your clock in the bottom right hand
corner of your desktop, like this:

A® . e

If you right-click the icon, you will see this menu:

v Show Metwork Warnings
v Show Metwork Connectivicy Changes

' Shiow Mew Mail Desktop Alert

Hide When Minimized
Open Outlook

This lets you choose if Outlook notifies you if you lose connection to your network/Internet or when you receive
new mail. You can also choose to hide Outlook when it is minimized, meaning that it will not appear in your
taskbar, just your system tray.

Click Open Outlook to maximize the Outlook window.
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Setting E-Mail Options

To set e-mail options, click the Tools menu and click Options.
Then, click the E-Mail Options button on the Preferences tab.

You will then see this E-mail Options dialog.

E-mail Options

Message handling

| After moving or deleting an open item: | [N (g dA AR Rl

o

| | Close origing message on reply or forwad

Save copies of messages in Sent Ikems Falder
automatically save unsent messages

Femove extra line breaks in plan text messages

Sliaude nessdge | ieaders wlhien - eadiog o i

[ Advanced E-mail Options. ., ] [ Tracking Dptions. ., ]

on reples and forwards -

i{_{.l} When replving o a message

=ln IIncIude ariginal message bexk L |

When forwardirg @ message

!Include ariginal message bext “ |

Preflxeach inewith

E |
[ Mark my comments wizh:

| |
Lo |

Zarcel

—_—

In the E-mail Options dialog, you can control what happens after you move, delete, or close a message; how
messages are saved; and how plain text messages are dealt with. You can also control what is included in replies
and forwards.

Now click the Advanced E-mail Options button.

In the Advanced E-mail Options dialog, you can control the more advanced settings, including AutoSave options,
how you are notified about new mail, and settings for creating messages.

Make any changes you feel would be useful in the Advanced E-mail Options and E-mail Options
dialogs and click OK. If you don’t want to make changes at this time, click Cancel in both dialogs.
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Customizing the Quick Access Toolbar
The Microsoft Office suite underwent a major interface overhaul when Office 2007 was released. If you have used
previous versions of Outlook in the past, the main window for Outlook 2007 probably appears quite familiar.
However, if you create a new e-mail message, task, or calendar item, you probably noticed a significant change in
the interface. Menus have been replaced with tabs, and each tab contains a sequence of commands which are
shown in a ribbon.

Another aspect of the new interface you might have noticed is the Quick Access toolbar. This toolbar is located next
to the Office menu, just above the tabs. It’s a place to store your most frequently used commands and save you
from hunting around in the tabs.
Open a new e-mail message to see the Quick Access toolbar.

i"ﬁ_ i -

Message | Insert Cptions Format Text

Using the Quick Access Toolbar

By default, there are five icons in this toolbar.
R S

From left to right, they are Save, Undo, Redo/Repeat, Previous Item, and Next Item. Using the toolbar is as easy as
clicking the icon of the action you want to perform.

Hover your mouse cursor over each item in the Quick Access toolbar. You will be shown the name
of each command.
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Adding and Removing Buttons

The point of the Quick Access toolbar is to provide quick access to the commands you use most, so it makes sense
that you can customize it.

To add buttons to the Quick Access toolbar, click the drop-down arrow next to it. Then, click any
commands you want to add to the toolbar.

(On) d 9 0 &9 %‘4
[T | —Message | Theate stomize Quick Access Toolbar
r i Save

w& L._E _.% 7 Quick Print

Reply Reply Forward | De Prirt Prewiew
ta Al ) )
| BEE sl - Spelling & Gramrmar
W | Undo
| -.f| Redo

If a command has a check by it, it means it’s active and on the toolbar. To remove a command,
simply click it to remove the check.

Right-click a command in the ribbon and click Add to Quick Access Toolbar.

In the image below, we are adding the Reply to All command in the Message ribbon to the Quick Access toolbar.

IvD':E iﬂ 93 fa i Jpcorig SEAff oty < Mossago i ALY
-"Jl “zssage | .'IJ‘Tst".l Or:g‘lg'li.‘.r!; Fomrat Test

A G W Sy 2 | e B ¥ (30 82

Tep|l Ll Tk & e T b i Sk L et iurk Cattqcn*t Foll ohet Mz 25 Schd o
1 '_‘}; : [ EBender Uar Urread || ko Seibcte Cife voTe
I Lifskomize Quick &cce i Toolbar., Junk S | I | Tratinr I | Cnariots

Ehotwt C U CE &iocess Todlazr JElcve Thi2 RIDEQq

teli-ai wier | e Rik bon
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Moving the Quick Access Toolbar

Click the pull-down arrow beside the Quick Access toolbar and click the option to move the
toolbar beneath the Ribbon.

Here’s what it will look like after you move it:

S
r:ﬁn ! Upoommnz Stat Party. Wessage (TR
! fAesszge | s Spzions I aimnak Tewt
_ L — i & P . —
R x & S &, 5 gi Y" = 34 Fisnl IEJ
B & Safe - ot = "
— = L L_-} ; ll — | eteten - '
Feply Reply Morweid | Dzlese Moveto Create Cthe' | Dock vt duhe Cakrcocme [alowe Mo as i Srdta
toA| FodarT Rde Ndion:T |beqdes X _pT Unrzad | & Select = eficte
Respond - Actior: B 1S Sipdons T cine | Orclote
= = - -—
IE L I o T

To move the toolbar back to its original place, click the drop-down arrow and click Show Above
the Ribbon.

Using the Options Dialog to Customize the Toolbar
You may have noticed that the list of options in the Quick Access toolbar’s drop down menu is limited.

For advanced customization options, click the pull-down arrow next to the Quick Access toolbar
and click the More Commands item.

Customize Quick Access Toolbar
|E| Sawe
Cuick Print
Print Preview
Spelling & Grammar
|E| Undo
| v | Redo
Feply
Feply to &l
Forward
Celete
Mowe to Other Folder
|:I" | Previous Item
|V | MextItem
| Mare Conmandsa [’\\S
Showe Below the Ribbon -

Minimize the Ribbon
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This will open the Customize tab of the Editor Options dialog.
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This dialog lets you browse the entire list of commands available in Outlook 2007and select commands to add to
the Quick Access toolbar.

Select a category of commands from the combo box at the top of the dialog. Now choose a
command from that category and click Add.

This will add a command to the Quick Access Toolbar list on the right.
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To remove a command from the Quick Access toolbar list by highlighting it and clicking Remove.
You can also use the arrows to change the button’s position in the list.
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You will also find commands to show the toolbar below the ribbon and to reset the toolbar to its default state.
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Customizing the Outlook Screen

Once you have customized the Quick Access toolbar to your liking, you will already be well on the way to working
more effectively in Outlook 2007. However, your customization options are not limited to just the Quick Access
toolbar. Let’s take a look at some of the other customization options available in Qutlook 2007.

Customizing Toolbars

Open Outlook 2007.

There are two ways to control what icons appear on Outlook 2007’s other toolbars.

The first method is to click the drop-down arrow on the far right-hand side of a toolbar.

R 4 @ | Sendy/Receive » 3 | [} Searchaddressbooks = | (@) =

Next, point to Add or Remove Buttons and then point to Standard to see a list of commands.

It_'%' [ Searchaddressbooks ~ | (@) __“

Show Buttons on One Row

|&dd or Remaove Buttans = Standar v |l S Mew
Custamize., v 3 Print., Ctrl+ P
[v 173 Move to Folder
v X Delete Chrl+ D
¥ 4 Reply Chrl+ R

Commands with a check are on the toolbar, commands with no check are hidden.

Click a command to change its status from hidden to visible and vice versa.

The other way to customize a toolbar is to click the Tools menu and click Customize.

This will open the Customize dialog.
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Click the Commands tab. Choose a category from the left and a command from the right. Then
simply drag and drop the command from the list onto a toolbar.

fctions Help

W @Repl_ytu.ﬂ.ll :_-—;}Fcur'u_irard E T @

[l Search address books

| @ =

7

L Inbox

@SEHWRE;EWE - u_\‘}
M
L)

|'5r arch Inbas

Py

Arranged By: Date

Mewest on top

1= older

—

While the Customize dialog remains open, you can right-click any toolbar button to customize it.

Susan Harris
Accounting Report

Susan Harris
Upcoming Staff Party
Microsoft

Canadian TechiMet Flash: ]

PoreerPaint User
Please review 'Lesson 4.1

Customize

| Toolbars | Commands | Options |

|,.

Accounting Repo

Susan Harris [velsc
Sent: Tue 241372007 113
Ta velsafti@modomail .o

To add a command ko a toolbar: select a category and drag the

command aut af this

Cateqories:

Edit

Viewy
Favarites
Go
Tools .
.
Help

Macros

|Menu Bar ™)

Modify Selection ’ Rearrange Corrmands. .. ]

q box ko & toolbar,

e A

' et Mail Message Lsing
More Skationery. .. .
Flain Text
Rich Text
HTIML (Mo Stationery)
W Follow Up

Close

Creating Toolbars

As you become more proficient with Outlook 2007, you will become used to using more commands. We know that
the Quick Access toolbar is great for adding commonly-used commands, but if you add too many commands, you

nder that

will end up with a cluttered toolbar. The solution to this problem is to create your own toolbar, right from the

ground up.

Having a custom toolbar might be useful if you occasionally use Outlook 2007 for very specific tasks. Imagine that

every week you commonly use six commands to complete a task. Instead of adding those six commands to the

Quick Access toolbar but only use them once a week, you can create a custom toolbar that can be opened when

you need it, and closed when you are finished.
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Open Outlook 2007 to your Inbox folder.
To create a new toolbar, open the Customize dialog from the Tools menu.

When the Customize dialog box appears, click the Toolbars tab and then click the New button.

Customize : [z]

| Commands || Cptions

Toolbars:

|— Skandard .
] advanced — k
Meru Bar [
[ ]web

[ ] Business Contact Manager for Outlook

Enter a name for your new toolbar and click OK.

Mewr Toolbar

Toolbar name:
|M~;.-' Toolbar| |

L ok J [ Cancel ]

The toolbar will then appear on screen. Back in the customize dialog, click the Commands tab. Select a category,
and then drag and drop a command from the list onto the toolbar.

Custoniize

Taolhars | Commands | Optians

i

Toadd a command to & koolbar: select a cakeqory and drag the
command out of this dialog box to a toolbar,

Zakegories: Commands: /
Eilﬁ: e Mew Mail Message Using bt
| - A Z
View Mare Stationery... il
Fawarites = :
G Plain Text
Tools g
[ Rich Text
e
Help HTML (Mo Stationery)
Macros
Menu Bar %) ¥ Fallow Up P
Modify Selection = [ Rearrange Commands, .. ]
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You will also find commands to rename and delete custom toolbars and reset default toolbars on the Toolbars tab.

Customize

Toolbars | Commands " options

Toolbars:
] Standard Mew, .,
|| Advanced
L |'Web =
|| Business Contact Manager For Outlook
£a|My Toolbar —
Resel,

When you have added the necessary commands to your toolbar, click Close in the Customize dialog box. If you
want to customize your toolbar later on, you first have to open the Customize dialog box.

To practice this concept, create a custom toolbar with five commands
Customizing the Menu Bar

If you prefer to use menus instead of toolbars, you can add extra commands to the menus that you use most often.
Customizing the menu bar is a lot like customizing toolbars.

First, click the Tools menu and click Customize, and then click the Commands tab. Now you can
drag and drop any command you like directly onto the menu bar or into a menu.

S OFle  EdiL ﬂi:l:'uf Zu | Tuuls 'EI.L ury  Eelp
.-'rj Aewr v IE:"'H { L Mail Cri+1 :=_‘:_.§'il:r_|ufF.l:l=tirl: w| [ Geachadersss socks = | G =
z ﬂ Calendar Cfel+? :
Mail : datien Level - Outleok Teday
r— B Coatasts i+l —
avorite Folders 7 ar
Ditan VoL FE e =] Taski Ctrl+d 1da
| Mokes Ctrl+5
Pelail Fulule s - .
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i #| Saorogss Cirle? o rd i
= E5T Foundztion Le :l palbers | AmAncs | gpdor |
,..E Journal ;I._tr|+i3 5 add = commard ko a tooloar zeect acatagory ard d-agthe
iy E‘“Fl"\‘ rrnand Juk of thE:dIEltlEl b Eo a toalbar,
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Deletzd Tkems i
] e
[evorkes
Vel Srosgser
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Help Lreernet Lall
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Meribar % older.., v
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As is the case with toolbars, when the Customize dialog is open you can right-click on any menu or command to
customize it.

Creating New Menus

In this last command customization topic, we will explore how Outlook 2007 lets you create custom menus. There
are two ways to create new menus.

The first method lets you drag solitary commands right into the menu bar. Because the main Outlook 2007 window
does not use the new Office 2007 interface, dragging commands into the menu bar lets you create a “mini” Quick
Access toolbar.

First, open the Customize dialog box by clicking the Tools menu and then clicking Customize.
Choose a command and drag it onto the menu bar.

EﬁiIE' Edit  Yiew Go Tools Adions ﬂelplﬁ
Fmia B S |'a;

This will place an icon in the menu bar.

S File Edit iew Go Tools Adions Help g’j e

FdMew v gg 2 X g Beply (@ Replyto All (g Forward

To delete a command from the menu bar, make sure the Customize dialog box is open, then right-
click the command and click Delete.

Ev]
EfiF Reset
Delet
viccess Lt
Mame: Folder..,
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The second way of creating custom menus is to drag the New Menu command from the Customize

dialog box to the menu bar.

Customize

| Toolbars | Commands | options

To add a command to a koolbar: select a cakegory and drag the
command out af this dialog box ko & toolbar,

Cateqories:

Commands:

Tools

Actions
Help
Macros
Menu Bar
Skandard
Advanced

Now you can add commands to this new menu the same way we have added commands to existing menus and

toolbars.
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Add a new menu to the menu bar and add five commands or groups of command to the bar.

Remember, to delete or modify a custom action for toolbars or menus, the Customize dialog box
needs to be open.
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Using the Options Tab

There’s one more thing in the Customize dialog that we haven’t looked at, the Options tab. These settings are used
to modify how menus and toolbars will behave on your screen. The default options for Outlook 2007 are shown

here:

Customize

Personalized Menus and Toolbars

Shiow Standard and Formatting toolbars an bwo rows
Always show Full menus
Shot Full rmenus aftar & short delay

[ Reset menu and toolbar usage data ]

Other
|:| Large icons
Lisk Fiont names in I:Ijair faonk
Show ScreenTips on toolbars
Show shorbcuk keys in ScreenTips

Menu animations: |{S';.f5tem default)

Open the Customize dialog and modify three things in the Options tab.
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Customizing Your Panes

Using the Reading Pane

Before we cover how to customize panes in Outlook 2007, let’s review the default items visible in Outlook 2007
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Select a message in your Inbox folder.

The Reading Pane (also known as the Preview Pane) will show you a preview of the currently selected item.
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Earlier you learned that the Reading pane can be shown on the right or bottom of the screen, or
can be turned off completely. For more advanced options, click the Tools menu and click Options.

Click the Other tab and then click the Reading Pane button.

Then, you will see a small dialog that will allow you to control the behavior of the pane.

Reading Pane

Reading Pane options

[ ]tark items as read when viewed in the Reading Pane

Wait |5 secofds tefore matking ke as read
Mark item as read when selection changes

Single key reading using space bar

[ ok 1[ Cancel ]




TIME MANAGEMENT "

Using the To-Do Bar

The To-Do bar is a new feature in Outlook 2007. This bar is visible in To-Do Bar # X | allfolders
except the calendar and provides quick access to upcoming tasks and i e R
appointments. s M TW T F s

5 29 1t 2 5

48 & 7 8 91
The top section shows the current calendar month and upcoming 11 12 13 14 15 16 17
appointments. Any appointments that have been added to your 18 13 20 21 22 23 24 | cglendar

make the date on which they fall appear bold. In the picture below, notice that

25 26 27 28 29 30
the 5" and 9t of November are in bold, meaning there is an '

appointment scheduled sometime that day. Charity Dinner
f:00 P - 9:00 PhA
TEA,
To-Do Bar » X

Staff Meeting
Fri 12:00 Pr - 1:00 PR
Boardroom

Ivl Movember 2007 hI
i O
a[ 8] & 7 & 9 10
11 12 13 14 15 16 17

1§ 19 20 21 22 23 24
25 28 27 28 29 30 Arranged By De Date |"‘

I Twpe a news task I

Charity Dinner

£:00 PM - %00 P =\ This Week

TBA, : \‘
: Prepare rep.. = 1
Staff Meeting g g

Fri 12:00 PRA - 100 PR

Boardroom

You can use the arrows to navigate through the calendar months, or you can double-click an appointment to open
it in your calendar.

If your calendar currently contains any dates with appointments, double-click the date to open
your calendar to that date.

The bottom section provides tools for tasks.

Create a new task now by clicking inside the text box that states “Type a new task.” Type “Sample
Task” into the space and press enter.
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Once you have entered a task, you can customize how Outlook will handle this task. The three buttons to the right
of your task, from left to right, will do the following.

The bell icon indicates that you will be reminded of this task; double-click it to change when
you will receive a reminder message.

The square in the middle lets you categorize a task. Click the square to assign the task to a
category. We will cover categories later in this manual.

The red flag, when clicked, marks the task as complete. Click this flag now to mark the
Sample Task as complete.

Arrange catering|

=l N\ This Week
‘Ptenare rep.. J3& Y

To customize the appearance of the To-Do Bar, click the View menu and point to To-Do Bar.
From this menu, you can choose the position and components of the bar.

Click Options. This will open the To-Do Bar Options dialog.

To-Do Bar Options E [Z|

Show Dake Mavigator

Mumber af month rows: 1

Show Sppointrnents

Mumber of appointrments: _3—|

show Task List

L 4 ,] [ Cancel ]

Click OK once you have made any changes or click Cancel to close the dialog.
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Summary
Outlook lets you customize just about every aspect of the interface. How you decide to customize is up to you, so
take some time and add or remove as much detail as you like. You can change the Quick Access Toolbar, the layout
of the screen, and even create your own custom toolbars and menus.

Review Questions

What does the Notification icon do?

What does the pull-down arrow to the right of the Quick Access Toolbar do?

Where can the Quick Access Toolbar be displayed in relation to the ribbon?

Outlook 2007 lets you customize the Quick Access Toolbar, but this toolbar is only visible in one of the
interfaces. What two other interface items does Outlook let you create/customize?

What items does the standard To-Do Bar display?
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The Four D’s

In this Module, we will learn how to:
Use the Do, Dump, Delay, and Delegate techniques to help manage our time
Edit e-mail messages you have received
Reply and forward to e-mail messages
Download and open attachments
Delete unnecessary e-mail messages
Create and manage Outlook Tasks
Send Tasks to others and manage Tasks sent to you

Do, Dump, Delay, and Delegate

Do, Dump, Delay, Delegate: these four D’s can help us manage our time better.

Do it Now

Do you spend a lot of time looking for things? Research tells us that the average person spends about 10% of the
day looking for documents. If that were so, you could gain 5 weeks a year just by getting your retrieval methods
under control! If you do have a filing system, make sure you stick to it.

Handle the little things that reduce concentration and cause anxiety, like the clutter on your desk and the
incomplete jobs. This is the opposite of prioritizing. Do the quick and dirty tasks NOW! The crises in our lives are
often the result of not handling the little things or not reacting to a niggling feeling that something is wrong. Ignore
the little toothache and you wind up with a root canal.

Another technique is to handle the worst things first. We create more stress and anxiety, and waste more time and
energy, over the things we least like to do. Why not just do them?

Try the salami technique: break things down into small steps and get started. That is how we eat an elephant, one
bite at a time.

Dump

Get rid of things you don’t need. This will take some practice and a hard-nosed approach if you have a tendency to
hang on to stuff. If throwing it out is too difficult, give it away, or ask someone else to throw it out for you. We will
discuss how you can effectively get rid of things later in this manual.

Delay

Occasionally we have legitimate delays, for example, if we are waiting for somebody else to get us information or
complete a task. However, if you have deadlines, pass on deadlines to others as well. Don’t let someone else’s lack
of planning short-circuit your deadlines.

Delegate
Don’t waste your time doing things that somebody else can do, especially if they can do them better than you. Save
your time for those things which you are uniquely qualified to do.
In The Creative Edge, author William C. Miller defines five levels of delegation:
Tell: “Based on my decision, here’s what | want you to do.”
Sell: “Based on my decision, here’s what | want you to do, because...”
Consult: “Before | make a decision, | want your input.”
Participate: “We need to make a decision together.”
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Delegate: “You make a decision.”

You must find ways to delegate, no matter what your position is. Learn to clearly define who is to do what and let
go.

There are five steps to the delegation process:
1) Explain why the job is important.
2) Describe what is needed in terms of results (not how, but what).
3) Give the person the authority they need to do the job.
4) Indicate when the job needs to be completed and get agreement.
5) Ask for feedback to ensure a common understanding.

The Story about Everybody, Somebody, Anybody, and Nobody

There was an important job to be done and Everybody was asked to do it. Everybody was sure that Somebody
would do it. Anybody could have done it, but Nobody did it. Somebody got mad about it because it was Everybody’s
job. Everyone thought that Anybody could do it, and Nobody realized that Everybody wouldn’t do it. It ended up
that Everybody blamed Somebody when actually Nobody blamed Anybody.

Why do we resist delegating?

Why do we resist having others delegate to us?

What are some important things to remember when we delegate?

Do: Working with E-mail Messages

Now that we understand the concepts behind the Four D’s, we're going to explore how you can use Outlook 2007
to effectively deal with messages you receive. Let’s start with Do. We'll show you how Outlook 2007 can let you
deal with important things right away by actually modifying a message that was sent to you.

No doubt you have received an e-mail message in the past that didn’t provide all the necessary information or was
missing a step that you know has to be done.

Double-click an e-mail message that you know needs some extra information

OR

You can follow along with the example below by sending an e-mail to yourself. Enter “Account
Report” as the subject and add the following text:

Hi James:

Just a reminder that | need those figures by the end of the day today!
Thanks,

Sue
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If you have sent the e-mail to yourself, open it by double-clicking it.

Once the e-mail is open, click the Other Actions button and click Edit Message.

rl:' lg e g

| Message [

Feply  Reply Forward Delete Mowve to Create Block | Hotlunk

‘ oAl | Folder= FRule Actions~| | Sender
| Fespond Actions U pivairan Tes P
= p—
From: Susan Harris [velsoft@modomail.com] | Edit Message
To velsaft@modomail, com Recall This Message..,
o
Resend This Meszage..
Subject: Accounting Report i - g
U | Save Attachments b
Hi lames: ([l Forsard as Attachment

Now, click inside the message and add some extra information. Next, click the X in the top right
hand corner to close the message. When you do so, you will be prompted to save the changes to
the message.

Click Yes to save the message.

Microsoft Office Outlook @
‘The body of the message "Accounting Report” has been changed,
!. 5 Do ol wank ko save changes to this message?

[ Yes ] [ M ] [Cancel ]

Once you save your changes, you will see the edited message in its original location. When it comes time to refer
back to that edited message, you can count on Outlook remembering the important details for you.
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Keeping yourself “in the loop” should obviously be the most important thing you do at work! In the example on the
last few pages, we have seen how you can edit a received message to include extra information that is relevant to
you. However, if your addition to the message is something that should be known by others, you should reply to
the message. We will now continue with the “Do it now” approach to getting things done and discuss how to reply

to messages.

Replying to Messages

To reply to a message, select it in the main window and click the Reply button on the Standard

toolbar. You can also use the Ctrl + R shortcut.

Now double-click a message in your Inbox to open that message. You will find the Reply and Reply
to All commands on the Respond group of the Message tab. (The Ctrl + R and Ctrl + Shift + R

shortcuts are still valid.)

|;| = R O
hMessage

I ==

B 3a X 25 3 & e

i Feply  Reply Forward | Delete Mu:u'u'etu:u Create Other Block i Hetlung
to Al Folder= FRule Adions> || Sender

| Respond Actions Junk E-mall P

From; Su=an Harris [velsoft@modomail, com]

To: velsoft@modomail, corm

i

Subject: Accounting Report

Hi lames:

Once you perform either the Reply or Reply to All commands, you will see this window.
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At the top, you can enter the e-mail addresses of other people who might be interested in this e-mail. Notice that
the original sender is already entered in the To field, and the original subject line is included with RE: before it,
indicating that the message is a reply. If anyone was a Cc recipient of the original message, their address will not
appear in the message. Don’t forget to include them if the message contains information they need to know!

Here's a quick overview of the three address fields:

To Messages are addressed directly to these recipients.
Cc Messages are copied to these recipients.
Bcc

Messages are copied to these recipients, but their address is not visible to
other recipients.

Back in the Inbox, you will see a purple arrow in the message list indicating that the message has been replied to
You will also see a message in the Reading Pane indicating when you replied
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Practice replying to an e-mail by sending a message back to someone. You can also reply using
your own e-mail address.

Forwarding Messages

If you want to send the message onto another recipient, select the message and then use the
Forward command on the Standard toolbar.

; o o = | s T , =
._%Re.plj,rtu‘&_ll ﬁ_‘.FDnﬂEr‘d{{ om ¥ @ = SendIRE_gewe @- [EH Search ac

_' ; Seho =
1 Inbox Forward (Ctrl+ F) L

Arranged By Date Mewest an top h, | o
=l Older
_a Susan Harris 23007

Accounting Report
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If you’ve already opened the message, you'll find the Forward command on the Respond section
of the Message tab.

fr L BIEOLUNTE REOCIT - Metzage (- R
JI hz: ’cage

EE B | Bpwence:| BY X (2| 8 o

Reph: Feay Fprﬁﬁ,ﬂ_ Diefebe: =0 : e T ||'z‘tegnr:ae Follow 'u‘arkas' Fiad | Saadta
o M| : |

Bl Other&ions = | Sender

| Ua= Unread hi Craedoke |
| Resaand Actons | umkEman Bl oneicrs 5l |l onemors |
Yo rap icd on| FNTRATT IO E)
Frori: 51 Forwaord this messoge to someanc Sentt Toe /L3007 1126 Ak
Ir: wi EliE,
o
Subject: Mcoounting Fepers
3 s
lilzmes ==
Once you click Forward (or use the Ctrl + F shortcut), you will see a window similar to the Reply window.
g@ e L I R s Kzport - Meczage (HIML)
| Mesiage | Insatz.  Ristass FarrEt est
== Lt : o =
] _i] A (calibriDo - - AT & || |F-E| ﬂ @ g A I_g ij }
i |y g e “E;"‘- = o i 5 =
Pastz 3 B T 'u = = == '_ Adciess e srtech Attach Judine:s Calendar 3. g'uatl.,ut
+ FlornatPaiatr ,l | A ” l lf - %) dcog Mame: sle kar  farcw
| Cieheard =1 Basclat Gl mawes | Inzude

I
I
_LJIT

Fvy foccunking Rzt

Trom: Zusa | laT s |mailto:velsat 2 nodonai oom |
Sent: Tuesday, Mebroary 20, 2007 L1:26 aM

To: v=lsath@rzdorisil.com

Subject: Accounting Rspoct

HI Jam =z

Note that all the address fields are blank. The subject line, however, is still the original, with FW: in front of it,
indicating that the message has been forwarded.
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All you have to do is type in your recipient’s address in the To line and your text in the body. When you’re ready,
click Send.

bD':' '.'.] AL e FA BCOOUrtng Hopor = Message (HI ML
— | Messace | Twet  Sphons

| == ! y =

= Jh ik Al Eo 7 g ; Ql IE_E] jﬁ j_,?

= ey e . e

EEste ; n ,r ag) z = {E Ear Mddress LFeck || Mtad Atmch Eudiness Lzlardar }IQﬂ:UJrE |
| - ..;"'-“."“'Et - her | El '& - I ]:.-_.li fiomt Rl | File Tlen  Canl- |

4 prana-i 3 Easis e i e | Ladice

*
Sahjril: |F'_R.,|' Ernandiqng Bl

HI wondys
Cenvyoumskz suretaesetigu-ss get'tl:n st
Tmacks

-ANES

Iram: Sisan arr s [ra hone sot@ nodorail corl
8rnt: Tussdsy, Sehmiary 13, 2007 ©1:70 68

Tz wekn G nodnrail.roes

Siibjevl: Suiuoriing Reporl

Hi Jarnus:

Back in the Inbox, you will see a blue arrow in the message list indicating that the message has been forwarded.
You will also see a message in the Reading Pane indicating when you forwarded the message.

T =
3 Inbox [Feen Do LB Accolnting Report
Aprzegzs Iu Dite Mo st ar 122 | wimaHar s e et arailemm |
= oiger
e R e s e e T Sea Taz &1E20CF 1535 MM
: R =

i R I vakzfza-odamalezm
e e SRR G e S R |
£ Swea He BRI | &

Lz zaminn .-:a"fl'-!b; H lzmes | |

Practice forwarding an e-mail to someone. You can also forward messages to your own e-mail
address.
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Opening and Saving Attachments

Often, if someone is sending a long document or a file that can’t be copied and pasted into an e-mail message, they
will attach the file itself. You can tell if a file is attached by the paperclip icon in the message list.

3 Inbox Search Inbo; o v| ¥ |
Arranged By Date Mewest an top | o
=] oider
| Susan Haris ELEEN T
| Accounting Report
=4 Susan Harris 2/13/2007
Upcoming Staff Party
=i Microsoft 1041942006
Canadian TechMet Flash: Special Bvents Edition - Launch 2007
4 PoweerPaint User a/21/2006 8 13
Please review Lesson 4,17

Highlight a message in your Inbox that includes an attachment.

If you don’t have any messages with attachments, ask someone to e-mail you and include an
attachment or e-mail yourself with an attachment. Once you have received a message, click the
message to highlight it.

If you look at the message details in the Reading Pane, you will see that a file is attached.

e } = . .
3 Inbox R Al Plennw revievs Lanson 4.1
Apsmegn 7 mn Dat Feswr e = = o s .
L A S RS ezl Ll s [pezwec o pes e i@ odoniai o |
=l tnrarr R
Leam WA RAITEL KT Ak AR
S hear 1ecas A1 160 ; i
A ;
Artanr=ag eaar peeaer poankin—damalecm
L bursr llz-1= AL ALy | _]hh"".‘i':.‘ Imlrnnn-&. ﬁ*‘.l'(l-"'ll.'FnI
| =aming St T
.
3 Micarct LU L4202 T
o ol M zaze review the sxtachee dacumer:
Camacdka s lee-"lebl =6l i we s e - Ba ek A
» deme WAL
e o e s e e Lt s e

Right-click the attached file in the Reading Pane to see a list of options.
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Sents wwed 62152006 1156 Ak
T 'powerpoint@modamail com'

Preview

Open
Please review the attad .
Print

Sawe As

Remove

Before you open that attachment, there are some things you should know. Not all attachments are good. A lot of
people have gotten viruses by opening e-mail attachments. Here’s what you can do to protect yourself:

=  Only open attachments from people you trust.

= Check the file name. If it's something weird like, “I LOVE YOU!” you probably shouldn’t open it.

= Save the file to your hard drive and scan it with your antivirus software.

= [fyou’re in doubt, just don’t open it!

Outlook will also protect you by refusing to open certain types of files (like executables, files which are actually
small programs).

If you’re sure the file is OK, right-click it and click Open.

This will open the file in its native application (in this example, the file was a PowerPoint presentation).
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Close the program you used to open the attachment.
Back in the Reading Pane, right-click the file and click Save As to save it to your computer.

Note that messages with attached files can be forwarded and replied to just like other messages.



TIME MANAGEMENT "

Using the Attachment Previewer

If someone sends you an attachment but you don’t have time to properly view it or save it to your computer, you
have the ability to preview the file. This preview option is new to Outlook 2007.
Open a message with an attachment, right-click the file, and then click Preview.

Please review 'Lesson 4.1°

PowerPoint User [powerpoint@modomail.com]

Rewiein,
Sent Wed 6/21/2006 1156 AM
To: ‘powwerpoint@rmiodamail, com'

...................................

Previewy %

Please review the attached Dpen
Print
Sawe &,

Remole

You will be asked to verify your choice.

As with all attachments, you should only preview files that you trust.

i Message | E]lesson 4.1ppt (409 KB)

\_ﬁ You should only previewr files from a trustwrorthy source.

Previewing the file might not show the full content af the file, Ta see
the most complete, up-to-date content, open the file,

Always warh before previewing this type of file,

Click Preview File.

This will show a glimpse of the file in the Reading Pane. Note that not all file types can be previewed this way. If you
are unable to preview something, you will have to download the attachment and then use another program to
open it. As with all attachments, you should only do this if you trust the message source.
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Marking a Message for Follow-Up

If you simply don’t have time to deal with an important message but also don’t want to forget about the message,
Outlook 2007 includes the ability to automatically alert you about a message after a given period of time.

Open an e-mail message you want to follow up on later.

Click the Follow-Up command on the Message tab and
reminder flag.

Once you have selected a date for follow-up, Outlook 2007 adds a
your list, using the e-mail’s title, to the specified date. For example, if
follow up on the “Accounting Report” message tomorrow, a new task
“Accounting Report” would be entered as a task for tomorrow.

Select a time to follow up, and then close the message.

W Tomorrow

% This week

o Mext ek

W Mo Date

W Custom..

A | Add Reminder...
Clear Flag

Flag for Recipients...

select a

new task to
you wanted to
titled

To add a follow-up flag for recipients, click the Flag for Recipients command. (Note that this typically only works

when the recipient is also using Outlook.)

In this dialog, you can create a custom flag for yourself or recipients. Once your options are set, click OK to apply

them.

Custom

Flagging a message for yourself creates a to-do item that reminds you to Follow up. After
voul Follow up on the message, you can mark the to-do item complete, Flagging a message
fFar the recipient sends a flag and a reminder with your message,

[IFlag for Me

Dusdate

Reminder:

| [ ]

Flag for Recipients

Flag ka: |F-:u||u:uw up

L o
_Eg Reminder

; |r'-’I|:|n|:Ia~;fJ Movember 05, 2007

v | |4:00 P v

Ok [}%[ Cancel ]
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To set follow-up reminders on a message that you have received, right-click the message in the Inbox. Point to

Follow Up and then select Add Reminder.

Add a reminder to the message you want to follow up on.

3 Bugs Bunny
i Staff Party

2/22¢2007

-1 Bugs Bunny
Sales Meeting
|| sarah Harris
Sample Logo
| Sarah Harris
heeting Friday
(1 Sarah Harris
Pally's Report

-1 Microsoft

Canadian TechMet Flash: [

Qpen

Print

Reply

Reply to All
Forward
Follow Up
Categorize L‘\-S
Mark as Unread
Fird All

Create Rule...
Junk E-mail
Delete

Move to Folder..,

Message Cptians...

Send to OneMote

CENAE<C %A

Today
TOrnOrE e

This Week
MextWeek

Mo Date
Custan..,

Add Reminder...
Mark Complete
Clear Flag

Set Quick Click..,

Note that you can also clear the flag or mark the follow-up complete with this menu.

Finally, remove all flags and reminders from the message.

Dump: Working with Deleted Items
Earlier in this Module, we introduced the Four D’s to help you get things done. Now we'll look at the second D,

Dump. Getting rid of excess things you don’t need will take some practice and a hard-nosed approach. Ask anyone
with a job that requires the use of e-mail and they’ll more than likely tell you that they always receive too much of

it.

Outlook 2007 does a very good job of filtering out junk messages, but you shouldn’t put complete faith in Outlook’s
ability to filter all the messages correctly. Occasionally junk mail might slip through into your Inbox, and
occasionally valid e-mail gets filtered as junk. In fact, the number of junk e-mail messages sent annually number in

the tens of trillions.

However, but we’re not concerned with the items you know are useless. Instead, let’s focus on reducing the
number of useful items whose subject matter has already been dealt with. In the next Module, we will cover some
techniques to help manage your files, either physical or electronic. But for now, let’s quickly go over the four
categories of files we believe are the best for getting things sorted:
Working Files: These include your current projects, routine functions, quick references, etc.
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Reference Files: These are files you must refer to frequently as you work with your Working Files.

Archive Files: Files you don’t look at anymore, but ones you need to keep for legal reasons or for other
important information that would be lost if you did completely dispose of them.

Disaster Files: Ideally, one file that contains all vital information like identification, financial information and
references, etc. that you can take if you have to vacate the office immediately.

Anything that doesn’t fit into the above four categories can be disposed of. In the next Module, we will explore in
detail how you can categorize your files with Outlook 2007.

For now, we will discuss how to delete items in Outlook.
To delete a message, first select it in the main Outlook screen.

Select a message you know is safe to delete. If you can’t delete anything, send yourself an e-mail
with the topic “Delete Me.”

To delete a message, you can either:
- Press Delete on your keyboard
Click the Delete button on the Standard Toolbar
Right-click the message and click Delete
Click the Edit menu and click Delete

The message will then be moved to the Deleted Items folder.

To retrieve a deleted item, click the Deleted Items folder in the Navigation Pane to display its
contents.



TIME MANAGEMENT

Then, click and drag the deleted message back into the Inbox.

Mail i I@ Delated ltern_SI [szrch Delated Lo Pl
Favorite Folders £ || Atranged By Date Newyzst on top e
() Tnboie _;B'.:{h;ﬂﬂn&&ﬁﬁﬁ%ﬁﬂ@ﬂhnkﬁ _ 242007

O Unread tfaf : Miﬁmwfﬁéﬁﬁﬁﬁ.‘iﬁhﬂﬂﬁ?ﬁEﬁ'hiﬁ’}éﬁgﬂ’
_.'.J Fax Falawe U Fd

[ zentItems f,
Mail Folders &l F

e L
2] All MailTte ms
| = %';‘ Mcrsornal Folders ”

@ Dieletec tems l
[ 7 Mwafts [1] ‘

e ‘

,

L @ Junk Eemail [1]
@ Qutaox

The best way to permanently delete everything in the Deleted Items folder is to click Tools and
then click Empty “Deleted Items” Folder.

Tools | Adtions  Help

Send/Receive b

Instant'Search r

[l Address Book.. Ctrl+Shift+E
% Organize
@ Rules and Alerts...

Mailbox Cleanup..,

5] Empty "Deleted Items" Folder %

If you perform this action, you will be warned that the item will then be permanently deleted. Click
Yes to perform the action.
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Delay: Setting up Your Outlook Task List
Murphy’s Law states that if something can go wrong, it will. Sometimes things happen that are beyond our power
to stop or change. In that case, we must adapt or deal with the situation, then move on.

Anyone will tell you that writing something down is a great way to remember something. Outlook 2007 lets you
create tasks to help you stay organized so you can remember the big and the small. We have mentioned tasks in
the past, but now we will explore them a little further because this folder is a great place to manage the things you

have to do!
|'f To-Do List {Filter Applied) |
| Search To-Cio List 2 v| ¥ |
Arranged By !I;lun_a: Date Today on top : | 1

Type a rew task

=\ This Week

_ﬂj Call pizza place

GG

.ﬂ Prepare report for meeting £

Opening the Tasks Folder

Open the Tasks folder by clicking the Tasks button in the Navigation Pane.

)

[2__51 Contacts

@ Tasks @
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You can also click the Go menu and click Tasks or use the Ctrl + 4 shortcut.

When the folder opens, you will see a structure much like any mail folder, with the menu bar, toolbar, Navigation
Pane, To-Do Bar, and central window.
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Dwmar  Siim Harh Ll 1
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£ By iy
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3 Taik Tianins
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Creating a New Task

To create a basic task, type “Book conference room” into either red area indicated below and then

press Enter.

S i e ek —aln e -
L T [ PO 211 [ R L
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Double-click this new task in either the To-Do List or the To-Do Bar to open it.

You can see a new empty task pictured below.

.o

H9 0 +9

| Task l Insert:

Iy

?%I

= Book conference roam - Task - 08X

Format Text Add-Ins

W X 2

i

P & |

S v |

Save & | Delete Assign’ Send'Statu.s rAark 1 Qb;iuﬁn‘éigshelling

Close | Task Feport  Complete l’—'$ = * [
' Actions Show | Marage Task If Proofirig

Drige today,

Subject |B|:u:|k conferenice roam

Startdate:  |Fri 01/05/2009 | status: [mot Started -]
Due date:  |Fri 01/05/2009 | priorit: [Momal 7] % complete: [0 =

[T Reminder: |h,||:|r1|=_~

[~

|NDnE

j hﬂi Chirier: |J-:uhn Laika

&

ol

You can also create a new task by clicking the New button on the Standard toolbar; click the File
menu, point to New and then choose Task; or press Ctrl + N.

Now set a start date and a due date, set a reminder, and add notes.
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The image below shows a sample task that has been filled out.

Lride ir 4 dais,

Subject: iBl:u:nk conferenice room i

Start date: | Tue 11/6/2007 v| status; Mot Started
Due date: | Fri 11/3/2007 v | priority |Mormal % | % Completer (0% |3
[FReminder: |Tue 11762007 | | 11:00 A6 | Owiner: | Susan Harris

Call Barb to book conference rclclml

Click Save and Close.

Editing a Ta

sk

To edit a task, you can double-click an item in the To-Do List to open it and make changes.
Open the “Book conference room” task now.

When a task is opened, note the Mark Complete command and the status area in the task. These commands will let

you keep track of the progress of tasks and keep on top of overdue and upcoming tasks.

-

Dz fake |Fr M0 T '-'l PricHty: H i ual b %lt-mplete | K] e

|.|:|=IJJ U i) Jook conference oo - Tazk x
| Taxk I Tri~ral Fur 1 al T=x ﬁ
WXL el ¢ @ &Y d
Lawe 0 Liefate la:k [DEzals | szach ehd Statu [tk T Hasire o SEip fEtegqosme bolow PHvate | Lpelng
Caie Ta:k Rzaork § Comaleze § o Qicgarrenss 3 UE - =
Aclirs Shue Waditag e Taxk plian: Froufi-n
Suein ddags
Subedl; |Euuk Lurier2r Le raci |
Stascater | Tue 114672007 = W status: | Mot Startec “|

| Fru

Hin.er: |T|n- 154 NN7 ‘-'l |1':I'II' Al SNAT = AT

Cal

You can also right-click on a task to see editing options like Open, Print, Mark Complete, Assign Task (to someone

else), etc.

Mark this task as 100% complete and then click the Mark Complete command. This will close the

Baatocockeosfesanis room

task. (Note that it is not necessary to specify any percentage before you can mark a task as
complete.)
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Using the Tasks Navigation Pane

Click the Tasks link in the Navigation Pane to open that view.

By now, the Navigation Pane should look familiar to you. Let’s go over the different components.

Tasks &
O] All Task Ttems -
My Tasks #
W To-Do List

& Tasks

Business Contact Manager

Current Yiew

) Simple List

) Detailed List

() Active Tasks

{:} Mext Seven Dajrs
3 Owerdue Tasks
O By Category

O Assignment

{:) By Person Responsible
G Completed Tasks
C} Task Timeline

() Server Tasks

) Outlook Data Files
(%) To-Do List

b

Add Mewe Group
Customize Current Wiew..,

——
1) catendar
-] contacts

w2 (] ~
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At the top of the bar, click All Task Items.

£] All Task Itarms

S Dicle

_Ol:lL_u!.,l_r:_:lsL.z File _['l F_ul._l.-r'

|_"|=|_ﬂi£_g.|',jl:l.l_

WrToLe.::
I Tty

& Tezks n Archive Falzers

|| Current Yiew %

X fuplaLisb

i Ut Letanles Lisk

=F

This view allows you to search all of the Tasks in your profile.

warch 1o :k l:fw. e N ETE wlzn.

To search for a Task, enter a search term into the text box in the upper right-hand corner of the center pane

and press Enter.

In the next section, you can toggle between your to-do list (which shows incomplete tasks) and your tasks list

(which shows all tasks).

My Tasks
W To-Dao List

] Tasks

E Tasks in Archive Folders

b

In the middle of the pane, there is a list of views that you can choose
any of the radio buttons under the Current View heading to view and

Current Yiew

Simple List
Detailed List

e

from. Click
sort your

tasks. And at the bottom, we have our standard navigation buttons. Active Tasks

Mext Seven Days
Crwerdue Tasks

By Categony
Assignment

By Person Responsible
Completed Tasks

Task Timeline

Server Tasks

Cutlook Data Files

LR T o T o R o R

Add Mew Group
Customize Current Wiew,.,

T ta_ltndaf
&-| contads

| wotes




[N
TIME MANAGEMENT "

Using the Standard Toolbar

There are a few additional commands on the Standard toolbar for the Tasks folder.

D3 Hew - don (33 M| B | L epy Sl Reply ol 2 Foraard Y W G0 sesrchaddrecshooks = | (@) s

Let’s go over each command.

Creates a new task. (If you click the arrow next to New, you will have options

o Mewr - to create other items as well.)
@_J Prints the selected item.
L3 Opens a window allowing you to choose a folder to move the item to.
X Deletes the selected item.
74 Mark the selected task as complete.

& Reply Replies to the sender of the message you have selected.

a Repl to A SReelzlciSes;'o the sender and all the other recipients of the message you have
._-ap Forward Forwards the message you’ve selected.
= Categorize the selected item.
\d Flag the item for follow-up.
(L Launches the Outlook address book.
Saarch address books = Use this window to search through your contacts.

(7] Launches Help.

Customizing Tasks Views

Current Yiew =

Like the other folders, you can click a view in the Navigation Pane to apply it.
0 simple List

You can also click the View menu and choose Arrange By to see i) Detailed List ways to

sort your tasks. (The Current View menu offers the same view {7 Active Tasks options as

the Navigation Pane.) () Mext Seven D
Add some different tasks to your Task list and then use ) By Categiry Next Seven Davs|| - the View

menu to change how Outlook displays the tasks. o O

"C}' By Person Responsible
3 Completed Tasks

.;’:;. Task Timeline

{-_‘_’:' Server Tasks

) Outlook Data Files
%) To-DoList
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Delegate: Sending Task Requests

The final D we will introduce in this manual is Delegate: assigning tasks to others who are capable of the job.
Outlook 2007 lets you create tasks and assign them to other people. Outlook will also let you accept or decline
tasks that were assigned to you and send status reports.

Before we go into the nuts and bolts of sending and receiving task requests in Outlook 2007, let’s go over three
important things to keep in mind when you are faced with a task that may require delegation:

Develop the “right” attitude. Supervisors and workers are all there to do the job together, so be fair with
your workers and be ready to provide guidance.

Decide what to delegate and what not to delegate. There are some things that only you, the manager, can
do.

Decide who to delegate to what task. Poor delegation choices may seriously hinder your project.
Workers need to understand that they have been chosen for a task because their manager feels that have the skill
and experience required to complete the job. Managers and supervisors need to understand that they are required
to give effective feedback throughout the delegation process and be prepared to answer questions along the way.

Let’s go over the process of delegating tasks to others and dealing with tasks delegated to you.

Create a new task in Outlook 2007 using the New command on the Standard Toolbar. Click the
Assign Task command.

The new task window changes to look like a combination of an e-mail and a task, as shown below.

- o = g i
|’-E_==> - | R Liotitled - Task
e :
Task Insett Format Text LEdd-In; )
I i = = -
Ay e © @ BT @ Y
hip . cress Book y FS
i== E&ZJ A V¥ =8 '
Tesk |[Detail: Cancel &,Checkmawe: fecurrence Selp Cateqorize Follow Private: | Spelling
fasignrrent | SIETHIrER TR - [p= -
Scliur St fflcriaye Tdas Crabiurs Praufing

This message Fasnatheen s=nk

- = Subject: I

Stat daze: INnn= j Status: Ian'Har‘PrJ j

Due cate: INDF‘IE _ﬂ Pr ot |hlnrma| "I'I % Corrplete: IE% j

¥ Keep an updated copy afthis bazk or my task list
I¥ Send me a status rzporwihznthis task is complete

The top of the window lets you add a recipient and a title, just like a new e-mail message. Below that is an area that
lets you enter the timing details, status, priority, and percent complete.
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The bottom of the task lets you write the details of the task that is to be performed.

Fill out a task and e-mail it to someone.

- H9 Ve o 5 Bccounting report - Task — =
roa) | @

Task | Insert  FormatText  Add-Ins 7]

XFh w w0 2 HYay |

i

Delete D’etail.f; Cancel a/ Recurrence’ Skip Categorize Follow Private || Spelling
[ | Assignment CIccurrence bt p = bl |
| actions Shioo | Marage Task Siptions | Proofing \
.Thf's. message has not beer sent,
u&]nﬁﬂaﬁ.
To.., | |sumaune@cumpanv.cnm:
Subject: |.&|3_:|:_:L_mi_:ing report
Star date: |Wad N6s05¢2009 j Status: |N|:|t5tar1:ed j

Cue date: IFriDBfDSIEDDH J Prioity: |ngh “'"l % Complete: I j

v keep an updated copy af this task on my task list
¥ send me a status 'repu:-rtwheh this task is complete

o
Please download and fill out your portion of the accounting sheet from our central server. %

Click Send to assign the task.

Tasks that have been assigned to you appear in your Inbox. If you have the Preview Pane visible, you can see the
details of the task as well as the option to Accept or Decline the task.

L3 Inbox — e | % Declive

“ntrt b .y
(i s E TPS Raport

| &rizt ged 3y Dox ewvzal o _ape o l"

L{il.-\k'tc 1!)'

Logpad b b oo Mackiorald lar - Uﬂ,nl.l.-fEI:IH! 1o AR,
| Dogeocdaler Slarle oo 0052009, Jue o 04052022

e dat bl Elarla
] F 4h
Tomple w TR

1= Today

Pl s hers il o TRE vepealeboe '] el Deview Rucle: Pl cosee poge Tkl
Thanks,

Soott
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Double-click an assigned task to open it. The first thing you should do with the task is choose to
accept or decline by clicking the appropriate command.

Accept the task.

e .

Oa\iid 9 U« % )5 TPS Repart - Task - =X
o sagd
) e =
b | Task l Add-Ins (7]
— = = |
NI e
I 2 - i Reply to All |
Delete Task |Details | (Sccept Dedine | Assigh Send Status IFI:r}Iu:lw E_r':iejlrn'g.l
[ | [l | Task Report QFD’WH”?!- [ BT e
| Bitions | Show | spond || Manage Task | Dptions | F'n:ur;ufin__q_-h
Due today, - Accept
_@S]gng_d-p‘ys_cqtf:hdacﬁ_prﬁ Accept this task and add it to your
Subject:  TPS Repaort task list. :
Due date:  Starts on 047052009, due on 04052008
Status: Mot Started Priarity:  High ¥ Complete: 0%
Ouwener;  lohn Laska '
3
Please submit your TPS reports... don't forget to include the cover page this time.
Thanks,
Scott

Next, you have the option to send a default accept response or edit the acceptance response. If you send the
default response, the task will be added to your Task list. If you choose to edit the response, a new message will
appear that will be sent to the person who delegated the task to you.
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Choose to edit the response and click OK. You can enter a custom reply message and then click Send.

™

98 e+ = TPS Report - Task - =X

Eﬁ@&]% 5w g

Task 'L‘fetalis Lssign ‘Cancel ﬂ/ {a’tegn:rrlze Fu:uIEl:lw Frivate: | Speﬂmg
| , || Task dccept I Up ==
ﬁg._*l_:l_m_r_w_ﬂ . Sl . fatiage Ta sh* | _ Dptians Proofing |

This message has not been sent.,
Yes, [ acceptthis task.
Tao: Stk
Subject: |TPS Report
Star date: IM:::n 04/057/2008 ﬂ Status: |N|:|t5tarted

# )l

Due date: Ir--1|:|n 04/057/2008 ﬂ Priarity: |Hi§|h “"] 2 Complete: | 0%
I Reminder: |lone j [None j nﬁli

| » &5

I will make sure to include the cover page.l

Plea5e submit your TPS reports... don't forget to include the cover page this time.

Thanks,

Scott

If you open the task from the main window, your custom reply message is still visible. As you progress through your
task, you can send status reports to inform your supervisor of milestones or barriers in your work.
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Click the Send Status Report command.
This will open a new e-mail message complete with status information that is automatically generated by Outlook.

Add any additional information about the task and click Send, just as you would with a normal e-mail message. The
task owner will then receive the report and the task will be updated.

rf’::) = By BT O R Task Statis Report: TFS BEEOI - Messace [Rich Texm)
L] A ———
Message | IFsert uptions  bcrmat et
:‘h_?'l_ T b -
=) # ||| catibn po = | 11 - | AR (i 3 Eﬂ %ﬂ 'El E' Y = w
b 2 || |22 |r z Address Crede | Follaw [! b | sl
Gl B L U A === EiE ress Che ; ey | R
* = || — ﬁ— [ - i —r.||| Sook Mames @' Lt 4 I - |
;I:II|:rE:u:|a o | I Basic Text F ' Mames | Include = Cptions | Froofing

_I facat
sie. ||
SLhjzct |Task Status Pepo: TPS Report

Cever page has been grinted,

-—-0riginal Task——
Subjact: TFS Repeort
Priority: High

Start date: Mon 04/05/2009
Due date: Mon 04/05/2000

Status: Mot stared
% Complete: 0%
Actual work: 0 hours

Requested by: Scott

will ke sure Lo include he wver page.

Please submit your TPS reports... don't forget toinclude the cover page this time.

Ihanks,

Scott

Once you have completed the task, mark the task as complete.
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Marking a Task as Private

If your organization uses Microsoft Exchange Server, and you do not want a task’s details to be viewable by others,
you can mark it as private. Simply click the Private button on the Task tab.

& w

|Private ||| Spelling

-

' _I | Pronfing

Private

Mark this item as private so that
other peoplecannotsee the
details of it

This feature is also available for calendar appointments and contacts.

STING

Most people battle the habit of procrastination (putting off something you really want or need to do) more than
they would like to admit. And in spite of how good you are at setting goals, procrastination can sabotage your
personal and professional life.

Here are five steps to take the STING out of feeling overwhelmed and how you can use Outlook 2007 to avoid
procrastination.

S: Select one thing to do.

It really pays to keep your Task lists as up-to-date as possible. Asthe old saying goes, an inch of planning is worth a
mile of progress. If you have taken the time to organize and prioritize your tasks, you’ll always know what you should
do next.

T: Timeyourself. Check the clock, give yourself an hour, and go for it.
Y ou can purchase a simple kitchen timer and have it on your desk to provide a warning when your timeis up. You can
always set areminder using Outlook to warn you before atask is due.

I: Ignoreeverything else while the clock isticking.
Y ou can set Outlook 2007 to automatically check messages as little or as often as you want. To change the frequency in
which Outlook performs a Send/Receive operation, click Tools = Options = Mail Setup tab > Send/Receive...

button. Modify the “Schedule an automatic send/receive every minutes.” If you remove the checkmark at the
beginning of this option, Outlook will only check your messages when you click the Send/Receive command on the
Standard Toolbar.

N: No breaks until your hour isup.
Thisstep isreally up to you. Sit up straight, make sure you are in awell-lit environment, and take things one step at a
time.

G: Giveyourself areward when the hour isup.
How you choose to reward yourself is up to you, but we recommend a healthy snack or at least a few minutes to stand
up and stretch.
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Summary
There are lots of different factors that might hinder the way you work. We recommend you keep these Four D’s in
mind: Do, Dump, Delay, and Delegate. Don’t let your work become overrun with e-mail: only check your e-mail
twice a day when you are unlikely to be interrupted. Practice the suggestions in this module to help you effectively
deal with the issues that really matter. Outlook 2007’s Tasks are also a great way to help yourself (and others) get

things done. And remember, if you're feeling overwhelmed, remember the 5 steps to take the STING out of feeling
left behind.

Review Questions

What Outlook 2007 item can help you handle Delays?

What are the five steps to the delegation process?
1)
2)
3)
4)
5)

What is the difference between the Cc and Bcc fields in an e-mail message?
What is the difference between replying and forwarding an e-mail?

What are the five steps of STING?
1) S:

2) T:

3) I:

4) N:

5) G
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Finding What You Need

In this Module, we will learn how to:
Organize your physical workspace
Recycle what you don't need to keep
Sort physical and electronic files based on file type
Deal with e-mail
Organize your briefcase
Sort messages using Categories
Sort using folders and Category Search Folders
Search for items in Outlook 2007
Deal with junk e-mail

Organizing Your Workspace
Getting rid of clutter is one of the best things we can do to make a more efficient work environment. Remember
that electronic clutter still counts as clutter!

In this Module, we will go over the basics of organizing your physical workspace. We will also outline how you can
categorize Outlook 2007 to help deal with the e-mail you receive over the course of the day. Keep in mind that
we're not suggesting you use ALL of these sorting and categorization techniques. You can spend too much time
doing a good thing! We recommend you read through the concepts in this Module first and then decide which
method or combination of methods would work the best for you.

Let’s start with your desk. The object of this exercise is to purge both the work surface and the contents of the
desk. If the surface is already clear—great! However, if there are items on the desk, ask yourself if they are
necessary and/or in an effective location.

Check position of the desk:
- Is it facing the door and making interruptions more likely?
Is the lighting adequate?
Is the phone where it can be reached easily?
Is there a better arrangement possible?
Is the seating/chair adequate?

Your first step should be to get rid of things that should NOT be on the desk. Check everywhere. Look under the
blotter, on the walls surrounding the desk, in trays and drawers, etc. Collect all bits and pieces and de-clutter by
throwing out or noting information in an appropriate spot and discarding it, or filing it for the moment.

Then move to the contents of the desk. Focus first on the tools you use, such as pens, pencils, and erasers.
Check to make sure of the following:

Do you have all tools you need, and they are in good working order?

Tools are organized so like tools are together and easily accessible. Do you need to move any
useless tools? Do any of these tools need fixing or can they be discarded?

Group like items together (for example: stationery, envelopes, and stamps all in one drawer).
Store any oversupply is in a supply area. Would anyone else need some of the extra supplies?
Tools should be stored in a shallow desk drawer, not on the desk.
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We recommend you make four piles of all the papers they have strewn around, including those on the bulletin
board, under your ink blotter or desk calendar, and on chairs.

Take home/get out of office

Help yourself/giveaways to colleagues

Cool stuff you want to keep and display
Thingsto be filed or written into your planner

Set up a system where vital information is saved where it can be accessed easily, and then bits of paper can be
discarded. Clutter often prevents us from using our time efficiently.

Am | going to need torefer to thislater?
YES: File it
NO: Recycle it

Do | have a digital copy that will suffice?
YES: Recycle it
NO: File it

Isit directly related to me or will someone else have a copy that | can refer to?
YES: Recycle it
NO: File it

Do | need to keep thisfor legal reasons?
YES: File it
NO: Recycle it

Doesit fit in my filing system?
YES: File it
NO: Recycle it

If I fileit, will | beableto find it?
YES: File it
NO: Recycle it
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Sorting Based on File Type

The key principles of file retrieval are:
Group similar things together
Place them in their own space or container
Label them clearly

Four Categories
There are also some additional steps we can take depending on what kind of files you are trying to organize. We
can usually divide our files into four categories: Working, Reference, Archive, and Disaster.

Working Files
These include your current projects, routine functions, and quick references. These are the files where you have
80% of your work. These should be within arm’s reach. They usually contain the following:
The projectsyou are currently working on. Thisfile should be cleaned occasionally, to move projects to a reference
file or to eliminate duplication.
Fingertip infor mation you need on aroutine or daily basis, such as phone lists, client addresses, and computer codes.
A follow-up file for each person with whom you comein contact on aregular basis, where you keep track of all
correspondence with that person.
A filefor routine functions such as sales reports or other functions performed daily/weekly/monthly.

Since these files should be within reach, they might be in a large desk drawer. Make certain they are in file folders,
labeled in large letters, and then placed in hanging file folders that are also labeled.

Usually it is more efficient to label hanging folders by category, rather than by a letter of the alphabet. Then
categories can be alphabetized or color-coded. We will cover how to file Outlook 2007 items by category later in
this manual.

Reference Files

These are files you must refer to frequently as you work on current projects. This is where the bulk of your files will
be located. Since you use these files regularly, they need to be kept handy, but not necessarily within arm’s length.
The most important thing is to arrange all information in such a way that you can pull information out of the file
easily.

Key questions for you to consider as this file is set up:
What do | want to keep?
What do | need to keep?
If I wanted thisinformation, could | find it elsewhere?

Information that should be in the reference file includes:
Research for future projects
Past projects to which the client refers

It can be helpful to consider key functions or components of your job, and make these the major categories for
reference files. Other files might include:

Sponsor files

Administrative information

Cull all duplicates or useless paper. Have a recycling bin at the ready.
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Establish subject categories, and label both file folders and hanging files. Put the file structure on paper prior to
starting the filing.

Label file drawers and create a master list of files if the amount of information is large. Remember to use large,
clear print with a fine tip felt marker.

Archive Files

These are the files nobody looks at. You keep them because the law says you must, or because you are afraid you'll
need them if they are thrown out, or because nobody wants to take the time to do anything about them. They
should be kept in a designated location far from your work area.

Disaster Files

This is one file that contains all vital information, including identification and financial references, in case you have
to vacate the office unexpectedly. You can also have afile like this at home so you have things organized in the
event of a disaster.

Electronic Files
The key rule is that the file structure used in paper files and electronic files should parallel each other. This is all for
the sake of retrieval. Make use of keywords and search programs to help you find your files even faster.

In this information age, we have to know what we need to keep and what we don’t need to keep. Don’t keep what
you don’t need. Don’t ask, “Will | ever need this?” The answer is almost sure to be “Maybe.” Ask instead, “Where
could | get this if | needed it?”

E-mail

Werecommend you check your mail twice a day.
Checking your e-mail frequently is one of the big time-wasters of the modern office. Avoid it if you can.
Set aside two periods when you know it will be quiet and check your mail then.
Use separate accounts for personal and business mail.
To change the frequency that Outlook 2007 checks your e-mail, click Tools = Options > Mail Setup tab >
Send/Receive... button and then modify the “Schedule an automatic send/receive” field.

Filter the spam.
With all of the junk e-mail circulating today, it's vital to use an e-mail program that can filter it by dumping junk in

the trash before it gets to you.

Outlook 2007 does a very good job of filtering junk e-mail messages, but you should never be 100% reliant on any
junk e-mail filter. Sometimes legitimate e-mail will be filtered as junk and vice versa.

Filters can also help you manage your e-mail better. For example, you can filter mailing list updates, news, and
promotions, into separate folders and read them when you're ready.

Outlook 2007 refers to these filters as rules. Rules are procedures that Outlook follows when you receive a new
message that meets the necessary criteria. We will discuss Rules later in this Module.

Organize your addresses.
Use the Contacts folder rather than manually typing addresses. It is more convenient and accurate. Creating
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distribution lists for various groups of people that you send e-mail to can also save you time.

With Outlook 2007, you can add new contacts by double-clicking in a blank area of the Contacts
folder or using the New command on the Standard Toolbar.

When a new blank contact appears, you can fill in their information. (You need to enter at least
their name and e-mail address.)

If someone e-mails you and you don’t already have them as a contact, open the e-mail they sent to
you, right-click their name at the top of the message and click Add to Outlook Contacts.

From: Scatt | .
Ta: 'Dave £
e, “ohn | Schedule a Meeting..,
Subject: RE: &
2 31 Send Mail
Dave, Additional Actions ¥

Send Options...
If | can throw m =
i

Add to Qutlook Contacts
it but let them K = I}f

85 Look up Qutlook Contact..,

Do you have an Outlook Properties

55 Copy

Crinit

File your messages.
Organize your messages into folders or delete them as soon as you're done reading them or acted on them. Ensure
your Inbox contains only messages you haven't read or that require further action.

Outlook 2007 lets you organize your messages with colored categories, which we will cover later in this Module.

K eep messages simple.
Remember:
A short e-mail message is a good e-mail message.
Use a specific or descriptive subject heading.
K eep messages, especially replies, short.
If a simple “yes” or “no” will do, that’s all you need to say.

Briefcase

Your briefcase should be organized with:
Toolsthat are needed frequently when away from the office
Reference files that are frequently referred to such as telephone lists
Working files that are needed
A system for expenses

Look at your briefcase or whatever you use to carry important information around with you.

Are you prepared with extra paper and pens?
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Is your briefcase organized?
What if someone looked in your vehicle: what does your vehicle say about you?

Sorting with Categories
We learned in Module One how to use the View menu to arrange information. Now it’s time to use the
organization skills we learned in this Module to sort and categorize your information.

Categories let you organize your Outlook items by groups. For example, you could mark all mail messages relating
to a particular person with a certain color category. Outlook 2007 lets you categorize e-mail, Tasks, Appointments
in your Calendar, and Contacts.

Setting up Categories

To configure categories, click the Edit menu, choose Categorize, and click All Categories.

Edit |

9 Urdo il B
& Cut Corl-H
3 copy i+
54 Office dliphcard..,

|Z4 Paste Crl+s
S0 selzctal Chrls &,
W Delete CHel+ O
L% MawetoFolcer.. Chr+Shift+y

Copy to Fclder..

= Mark as Read |+
LY Mark asUnreac S+
Mark &ll a: Read:
Ed Categolize K Cleas &l catecote:

Credle Calegury Sedrchr Tululer,.,
Elue Caleyury

Croch Totegorn

Crrange Cat=gore

Purple Catedory

Red Category

BEDLE ¥

Vel o Cate J0m
Al Categories.. Q

Set Quick Cick..,

[ =]
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You will then see the Color Categories dialog.

Color Categories

To assign Color Categories to the currently selected items, use the checkboxes next to each
cakegory, Toedit a cakegory, select the category name and use the commands ta the right,

Mame Sharkouk key Mew. .,
018 oo oo
1] areen Category BanEE
1) orange Category

Purple Cateqor
DQ P aery Calor:

[ Red Category -

11| vellow Category |@—w
Shortcut Kew:
||{I"-J|:|ne]| » |

L (4 J[ Cancel J

Here, you can click a category and then choose to rename it, delete it, or add a shortcut key. You can also click the
New button to create a new category.

We suggest that you use the Rename command to assign a meaningful name to each category before you begin
using it.

Color Categories

Toassign Colar Categories ko the currently selected items, use the checkboxes next to each
category. To edit a cakegory, select the categaory name and use the commands to the right,

I Marme Shortouk key M.,
| |1 1 |Bugs Bunnyw

(][] ©range Category i
12 Purple Category =
olar:
1) Red Categary ot
||:| [ ] vellow Categary | = 5

If you haven't already begun to use categories, think about the three most common types of e-mail
you receive. Then rename the Red, Yellow, and Blue Categories to reflect the most common
messages you receive.
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Assigning a Category to an ltem

To assign an item to a category, click it to select it. Then, click the Categorize button on the
Standard toolbar and choose the category.

[~ Tnaox - Microsof: Outlook

S OElle Edls wlew 50 Tools  Adtlons  Help
DadMew w bp A3 ¥ CLBeply - gReplytodll o Forward |0 if Lt '—*11 SendfReceive = [ | (4] Searchz
= = ClearAll Zateqorier
Mail “ | L Inbex ] cta ff P:
Favorite Folders # | T R L& Create Category Searca Folder..,
: 3 — seatzh oo BUQS B'a.
Ciraa *odr Favonte =aiders Herp
bt Rio il U L &rangen B Date (] Bugs Bunny RS‘ BNl Mo
Mail Folders 2 @ scen categany B ek
= der T -
21 All Mail e ms ¥ o Wl ©Orange Zategory
e :
=] 'E’ﬁ' Advznced Level = \ :a?: y_;r_tr;w @ Purple Category Hisue,
Ltatt Parby
{a] CeletedItems ; : Med Cat
2 —_— =1 Bugs Banry @ S Wee're |
E-T.i Inbox fales Meetng |_| Yellowe Category taking
L& Junk E-mail [1] i Sarzh Harrs B AN Categarizs. exeryol
@ Giathns sample Logo 5
= = 5 ide Click.,
3 [J RSS Feeds =1 Sarzh Hatrs el Tharks,
L SentItems Meeting Friday '
# L search Folcers (-4 farzh Harrs RH2007 Bugs

You can also use the right-click menu or the Edit menu to assign a category.

If this is the first time you have used this category, you will be prompted to rename it and add a
shortcut key. If you choose a new color, this will create a new category.

Rename Category E|rg|

This is the First time wou have used "areen Category." Do you want to
renarne ik?

Mame: !Gﬁéem'ﬁétﬂgﬁfk' |

Calar; [:] % | Shorbcuk Key: | (Mone) W
J [ me |

L Yes

Note that you can assign multiple categories to an item. For example, the message below is assigned to the green,
blue, and red categories.
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Canacdian TechMet Flash: Special Events Edition - Launch

2007

bicrosoft [Microsoft@newslettersmicrosoft.com]

|| Breen Category.

sent Thu lU.H.':I.l"ZUUI':- fdd P
To kim

About Quick Click

Quick Click is a feature that lets you assign an item to a category with a single click. You may have noticed an empty
square icon to the right of an item, like this e-mail message. This empty square means that no category has been

assigned to this item.

Arranged By: Date

Mewest on top |“|L

= oider

(=1 Bugs Bumnry
Staff Parky

212272007 Q

) Bugs Bunny
i Sales Meeting

262202007
17

=4 Sarah Harris
Sample Logo

[~ sarah Harris

Meeting Friday

Click. ko toggle Quick Click category
Right-click For all options

272272007

If you were to click the empty square, the Quick Click feature will automatically assign the message to a particular

category.

To set the Quick Click category, right-click any empty square or Quick Click assigned category

and click Set Quick Click.

Now you can choose which category to use when single-clicking on the category column.

Set Quick Click

wWhen single-clicking on the Categories
column, add the Following categorsy:

|@ Red Category v |
| Ok, JJ} [ Cancel ]
LaX

You can always return to the Set Quick Click command to change the category.

Assign a Quick Click category and categorize some of the messages in your Inbox folder.
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Creating Category Search Folders

Now that you know how to categorize items, we’ll introduce the concept of Category Search Folders. These folders
are similar to the Rules we looked at earlier and can be thought of as a way to “categorize your categories” and in
fact all of your e-mail. When you open a Category Search Folder, Outlook scours your e-mail messages and displays
all messages that meet the category search criteria.

To create a search folder based on categories, click the Categorize button on the Standard toolbar
and click Create Category Search Folder.

F!'_':

Cleardl Cateqories

LB Create Categary Search Falder,., k

Red Category

Bl Blia Catannems

You will then see the New Search Folder dialog. Select any of the pre-designated Search Folders from the list and
then click the Choose button to customize how mail will be sorted in the folder.

In this example, we will select Categorized Mail as the Search Folder. Now click Choose.

Hew Search Folder

Select a Search Folder:

Mail Flagged For Follow up Ladll
Mail either unread or Flagged For Fallow up
Important mail
Mail from People and Lists
Mail From and to specific people
Mail from specific people
Mail senk directly ko me
Mail sent to distribution lists
Organizing _Mail
¢ Categorized mail
Large mail |

Customize Search Folder:
Show mail with these categories:

Ay Cakeqory | | Chu:u:use...[\%
L&

v

J

Search mail in: !P-dvanced Lewvel

[ o4 ] [ Cancel
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Put a check beside the categories you want to include and click OK.

Color Categories

To select a Color Categary, select iks cabegory check box, To edit a category, select the
category name, and then click & command.

Mame S_hu:urtu:ut ke MeEw. .,
[ Bugs Bunny

(][] ©range Category

Purple Cat
D @ _ |__|.r|:|_e : .a. EF!I:IW Colars
ey \“elln:nw Categn:nr':.-' |@—y
Shortout Key:
||:I"-.I|:|ne]| ot |

[ Ok ﬁ[ Cancel J

Then, click OK to close the New Search Folder dialog.

The new Category Search Folder will appear in the Navigation pane when viewing your e-mail. Any messages that
match the criteria for this folder will be displayed.

Mail « ||L2 Bugs Bunny or Red Category
Favorite Folders % |-, -rch Bugs Buriny or Red Category p v| ¥
E'l'; Your Favarite Folders Here .
Arranged Byi Categories Aontop | T
Mail Folders = 0
= @ Bugs Bunmy
2] AN Mail e ms - |

| i Bugs Bunny
o SmEPary. i

= 'ﬁﬁ Advanced Level

ﬁ Deleted Ttems

i Deafis = @ Red Category

:']Intu:ux "

[ & Junk E-mail [1] i Bugs Bunny 202202007 o
E@ Dutbox Sales Meeting

H [ R5S Feeds
L.-E SentItems
=] [;I:I Search Folders
[-;{:I Bugs Bunny or Red Category
L Categarized Maii
L Large maii
L Urrgad Mail
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Upgrading Categories

If you have upgraded from a previous version of Outlook to Outlook 2007 and have already used categories or
colored flags to filter your e-mail, you should upgrade your categories.

To do this, right-click on your Personal Folders file and click Properties.

=) E0F Advanced Leyal I
(3] Deleted I 7 Qpen
[ Drafts
[ 7 Inbox
'—__d Junk E-mq A8 Rename "Advanced Level”.,

Ll Outbax | = pew Falder.,

Cpenin Mew Window

H [ RSS Feeds:
[i_i SentItem Add to Favorite Folders
& L5 Search Fo Process &1l Marked Headers
Process Marked Headers
Cpen Cutlook Data File...
.: Cloze "Advaticed Lewel”

@" F‘ru:uner‘ties'fcur “Bdvanced Lewel”,., k

When the Outlook Today - [Your Folder Name] Properties dialog appears, click the Upgrade to
Color Categories command in the General tab.

Outlook will then confirm what it is about to do: upgrade colored and categorized items to the new color
categories. Click Yes to proceed.

dicrosoft Office Ootloeok

| Zaya. ek so uzarads matizsloesd For Falow UE -lace 2nd Lalendar Lshek “nikeanoed Level ' bo Color atzqoast Thes Zzn Ezke & Sizni cark
smunz of Bre cepsndng o- 29 rumber o° flacges =nd Isbeed k=mis ndvancasd Leesl”, Cut yvou can concrue uang 2uckos dmng the pg-ace

[ e 10 w |
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Using Categories in a View

In most folders, you will find a “Categories” listing under either Current View or Arrange By.

iew |
Arrange By 3 u"l Date
Current Wiews 4 Cormersation

i-:‘i AutoPreview From
Expand/Collapse Groups » Ta
ﬂawigatian F';ne . 3 Categories
To-Do Bar 3 Flag: Start DateR?

For example, here is our calendar after assigning categories to our items and using the View = Current View >

Categories command.

(= talendss M oosoft Lubdook

| “Cile: - Lelit: wiger | S0 Tezi

i

Lela

(B - s OLEE B RO searhoadireis bods - gw

lop= o icatn foe bep -

I
]
1
1
1
Calendar # |4 Calendar : [ =airnerie £l
] AR C ek Tem r 1R sazed L0mTIn il | | Cazzgotics | -
Iy Calendors - Sl e = add A mewe A, = -
B czienzar 3 : |
. * L F:._J.J A aygurie st S Caleoope |30 Lep 2 '
Pl e L Ll I Chamy L onoc I-1% Mzr || GFezhCategoy
S arch Cxlansats O- he | tenzres Merting wath ==k =k O e LTI | [ Gk Ctegaey
fend = Caeniderea Tomril 1= Catzgorc s [ 2 Cotegoes |1kl 1 =
T b by sl =, '-E = ff Meating Zoardraa [Et = i Purple Cabscony
| £l ]_I: H Cammgruie i Red Cabezane 1 1] :
'ii Train - yhharkhio MEC s wer i ] P Celeyuey

Our appointments are now presented in table view, grouped by category. There are many ways to use categories in
views; don’t be afraid to experiment!
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Managing Electronic Files
By now, you should be quite familiar with creating messages and working with the default folders in Outlook. There
are lots of ways to stay organized. Earlier in this Module, we covered how to use categories and Category Search
Folders. Now you will learn how to create your own folders to manage your mail manually.

Creating Folders

To create a new folder, you can click the File menu, choose New, and click Folder.

Eile.

P e
Open
Close All Ttems
@ Sawe &g,
Save Attachments
Falder
Data File Management,.,
Import and Export...

Archive...

You can also use the Ctrl + Shift + E shortcut, or right-click a folder and click New Folder.

You will then see the Create New Folder dialog.

Type a name for your folder. Next,
what type of items you want it to

Then, choose what folder you want to
underneath. Click OK to add the folder.

L4 _j_.'l Mail Message Ctrl+ M

r ‘f‘,J Postin This Folder Ctrl+ Shift+ 5
4 Folder... Ctrl+ Shift+E
L3 Search Folder.., Ctrl+ Shift+ P

L4 Mavigation Pane Shortout,.,

¥ |EE Appointment Chrl+ Shift+ &
ﬁ MMeeting Reguest CLrl+ Shift+ Q)
85 Contact Ctrl+ Shift+ C
ﬁ Distribution List Chrl+ Shift+L

Create Mew Folder

Marme;

Folder contains:

|Mail and Paosk Items

Select where to place the folder;

SRS Tritermediate Leve
Calendar
85 Contacts
&) Deleted Thems
L,j Drafts [1]

L:q Inbox (5]

SH Journal

if_a Junk E-mail [1]
| _a.J Mates

(4 outhos

(1 RSS Feeds

1 [ Cancel J

choose
contain.
place it
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Renaming Folders

If you later decide to change the name of your folder, simply right-click it and click Rename.

Pail Folders s
27 ANl Mail Ttems -

= '@ Intermediate Lewel
& Deleted fems
L7 Drafts [1]
[ |Inbox [5)
L @ Junk E-mail [1]
L My Far™
[ outbd & Spen
LF RS Fe Cpen in Mew Window
[ Sent I

= I:ﬂ Search

howe "My Folder”..

Coapy "My Falder”...
Dielete "My Folder”

Rename "My Falder”.. %

I

Mew Falder..,
Add to Favorite Folders

hark &ll as Read
Pracess All Marked Headers

Process Marked Headers

@ Properties

Your cursor will then appear in the folder name. Type a new name and press Enter.

= S8 Intermediate Level
(5] Deleted tems
L7 Drafts [1]
L Inbox [5)

[ My Mewy Falder

L) RSS Feeds
L1 Sent Items
H L& Search Folders

Note that default folders (such as Inbox and junk e-mail) cannot be renamed.

Think carefully about what sort of custom folders you might use during your work. Create two
custom folders and then rename them.
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Moving and Deleting Folders

To change the location of a folder, you can drag and drop it anywhere in the list of folders.

Here, we are dropping My Folder into the Inbox.

= E6t Intermediate Lewvel
ﬁ Deleted Ttems

@ Drafts [1]

L) RSS Feeds
(=] SentItems
L3 Search Folders

Now, the Inbox will have a plus sign next to it, indicating that it contains subfolders. You can click the plus sign to
show the folders, or click the minus sign to hide the folders.

Ma il 4
Favaorite Folders =%
Drag Your Favorte Folders H
Mail Folders =
2] All Mail te ms -

= 6 Intermediate Level
'_@ Deleted Ttems

Ca My.-' Mew Folder
L_d Junk E-mail [1]
(4 Outhox
(5| RS Feeds
L[] Sent Tems
H ._':;CI Search Folders

You can also right-click a folder to move, = 6 Intermediate Lewel copy, or
delete it. (5] Deleted Items
Lﬁ Drafts [1]

E [

LE Junk E mail [1]

[ My s

@Outhux% Epen

% RSS Fee Dpen it Mew Window

SentItefn
H LG search 0 hfowe "My Mew Folder”,.

in Copy "My Mew Folder”..,

4 Delete "My Mew Folder”

HIE Eename "My Mews Falder”,.,

4 KNaws Ealdar
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If you choose the Delete option, the folder will be moved to Deleted Items. If you choose Move or Copy, you will
see a dialog like the following.

Copy Folder

Copy the selected folder to the Folder:
= E_@' Intermediate Lewvel

] Calendar
5] Contacts Cancel
&) Deleted Ttems
L7 Drafts [1] Mew,
[ ) Inbox {4

S Jourmal

L__d Junk E-mail [1]
o
::_J Maotes

L4 outho

L) 55 Feeds

[ Sent Tkems

1 Tasks

!l

Here, you can choose a destination folder and click OK.

Moving Messages to Folders
Moving messages to your folders is easy!

The easiest way to move a message is to click and drag a message to your desired folder.

Mail « |3 Inbox

Favaorite Folders sl o Ty D v| ¥

|Cli|:k here to enable Instant Search |

Dirag Your Favorite Folders F

Mail Folders # | Arranged By Date Mewest antop | o
2] AN Mail tems - |
— e =] older

= it Intermediate Level P " :
1) Deleted Hems | i Bugs Bunny 222{2007
Lj Inbox (4] | Sarah Harris 272242007
L g Junk E-mail [1] sample Logo
EJEMF-?"QEWFU‘“E'E%:; | Sarah Harris 212242007
[ Outbox Meeting Friday
L R55 Feed 3
- b | sarah Harris 212242007

You can select multiple messages and move them in the same way.

Click a message, hold Shift, and then click another message to select a block of messages
at once. Then click and drag the messages.

Press and hold Ctrl and then click individual messages to select non-adjacent messages.
Release Ctrl, and then click and drag the messages.
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You can also select the message and click the Move to Folder button on the Standard toolbar. You can then choose
a recently used folder in the list, or click the More Folders button to see a complete list of folders.

[+ Inbox - Microsoft Outlook

: File - Edit 'iew Go Tools ‘Actions  Help
D Mew - 321K g Reply (4 Replyto &1l (o Forward | L | LA
: . | - : i : |
A My Folder
Mail
Favorite Folders DI SRR D v|
Orag Your Fava Inbox
: Search
5 Thhr —
Rail Folders Mewest an tap |
- Inbox
5] ANl Mail Tte ms
= Eg;. Yk ek gtk '.f’:" Mave to Falder,.,  Chrl+Shift+h
3 Deleted Items I Elgs Bunny 242242007
L7 Drafts [1] Sales Meeting 1]
__|Inbox [4] | Sarah Harris 212242007
L@ Junk E-mail [1] sample Logo.
i My-Hewr Foidler | Sarah Harris 242272007
"@ Gt Meeting Friday

Now let’s talk more about Outlook’s mail management tools that can automate the process of moving messages
around, including the Rules and Alerts Wizard and the Organize pane.

Creating a Simple Rule

Wouldn't it be great if every time you got an e-mail from your boss, Outlook moved it to its own folder? Outlook
has a feature to do just that; it’s called the Rules and Alerts wizard.

You can get to the wizard in one of a few ways:
= Click the Create Rule (ﬁ) button on the Standard toolbar
= Right-click an e-mail and click Create Rule
= Click the Tools menu and click Rules and Alerts

With either of the first two choices listed above, you will see this dialog:

This is a simplified version of the Rules and Alerts wizard, which we’ll talk about in a minute. It’s a great way to
create a quick rule.

The top part of the box specifies when the rule will act and the bottom part specifies what will happen when the
type of e-mail you’ve specified arrives. At least one of the boxes in each section needs to be checked for the OK
button at the bottom to become active.

Let’s go over the first set of boxes (“When | get e-mail with all of the selected conditions”):



5 B
ewveser
- From

This box is automatically filled in with the sender of the e-mail that was selected when you clicked the

Create Rule button. It can’t be changed in this window.

Subject contains

The white text box is automatically filled in with the subject of the e-mail that was selected when you

clicked the Create Rule button. You can edit it just by clicking in the white box, deleting the text that’s

there, and typing. (You can, of course, also modify the text that’s typed in there.)

Sent to

This message was sent to someone using a distribution list (a predefined group of contacts), so this drop-

down list contains both the name of the distribution list and “me only.”

The second set of boxes specifies what action(s) to take when the conditions in the first set of boxes are met (“Do
the following”):

Display in the New Item Alert Window

With the New Item Alert window, you can open the e-mail by clicking the Open Item button, edit the rule
by clicking the Edit Rule button, or just close the window.

Play a selected sound

Plays a sound when the e-mail arrives. (Normally Outlook plays a sound anyway when you get new e-mail,
but this is a way to have Outlook play a sound for only specific e-mails, or to set a custom sound for certain
e-mails.) Click the Browse button to pick a file; you can also click the Play button to hear the sound.

Move the item to folder

This is the most commonly used feature. This option will move e-mails that meet the conditions set out in
the first box to a folder that you specify. When you check this box, a window will pop up asking you to pick
a folder. (You can only specify one folder.)

Here is a completed Create Rule dialog. This rule will tell Outlook that when an e-mail arrives from Bugs Bunny, and
was sent to me only, Outlook should play the tada.wav sound, and move the e-mail to the Deleted Items folder.

Create Rule

‘wthen T get e-mail with all of the selected conditions

Friom Bugs Bunmny

[ ]5ubject contains |StaFF Party |

[¥]Sentto | me only ¥ |

Do the Folloming

[ ] pisplay in the Mew Ttem Alert window

Play a selected sound: Itada.wav | [E B

Mave the item to Folder: |Deleted Items Select Folder. .. ]

[ Ok _l [ Cancel ] [.ﬁ.dvanced Optiu:-ns...]
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Clicking OK will bring up another box confirming that the rule has been created. You'll also have an option to run
the rule on messages already in the folder, which will help if you’ve created the rule after a lot of e-mail has
arrived.

': The rule "sent only ta me" has been created.
L,

[ IRun this rule now on messages already in the current Folder

Create a rule that sends all mail from a particular person to a folder with their name.
Using the Rules and Alerts Wizard

If you click the Advanced Options button in the Create Rule dialog, you’ll see a more comprehensive view of the
Rules and Alerts dialog.

First, let’s look at the three parts of the dialog.

To launch the full Rules and Alerts dialog, click the Tools menu and click Rules and Alerts, or click the Rules and

Alerts button (L-fi) on the Advanced toolbar.

Barles and Alerts

E mail Rules | g PRI |‘:'||l:1'|.:-!

E} MewRue... Chenge Fule v 53 Copy. . X Delete 4 B Bin Rules Move... Dptions

| Rule {applied in the crder shawn) | dckiarns |
szt ony to me ¢4 z
Clear categarizs on nail (recommended) oy

Rue cescription (clck an und=tlined vaue ko edit);

Lpph this rule after -he messzge arrives
sent orly ko me

and Fram Rugs Frinny
and an this maching orly

rlay bada, way

and mave ik bo be Deleked Tkzms Foder

| Enable riles on all RSE Fesds

[ 2F I[ Carcel J Apol
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The toolbar at the top of the dialog gives you options to create a new rule; to change, delete, copy, or move the
selected rule; or to run the rule now. The Options button allows you to import, export, or upgrade your rules.

If you’re just looking to make a quick change to a rule’s action, the Change Rule button is the best way to do it.

Rules and Alerts

E-mail Rules | Manage alerts |

[ Mew Rule.., |Change Rule {453 Copy... )( Delete | o« & R
| Rule {applied Edit Rule Settings... _|
sertonly ko Rename Rule

Clear categor
Dizplay in the Mew kem Alert window

Play a Sound...
Move to Folder..,

Copyto Folder..,

Fule description (g Winrkaa TGl Rttty

apply this rule a fdark as Lo Priority

sent only ko me
and From Bugs

X « = (3 & &

Delete Message

All of the options in the menu are pretty self-explanatory: you can rename the rule or add different options. You'll
notice that there are some new options that we didn’t have in the Create Rule dialog box, like changing the
message’s priority. The options that are already in use for the rule are highlighted with an orange icon (for
example, Play a Sound and Move to Folder in the sample menu above). You can click those options to remove that

action for the rule.

The icons you see in the menu are important when we’re looking at the middle part of the Rules and

Alerts dialog.

E-mail Rules | Manage Alsrts |

oy

[ Mew Rule... Change Rule » 23 Copy... 3 Delete i+ % RunRules Mow, ., Dptions

|Rule {applied in the order shawn) |- fckions |
sent only tome d 05 _
Clear cateqgories on mail {recommended) ﬁ%"

Rule description {click an underlined walue to edit):

| Apply this rule after the message arrives |

This section is a list of the rules that are in place and the actions that Outlook will take. The actions are identified by
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the same icons that we saw in the Change Rule menu. In the list, there’s also a checkbox by the name of each rule.
If the box is checked, the rule is on; if the box is unchecked the rule is off. You can click in the checkbox to change
this on/off status.

The bottom part of the Rules and Alerts screen will give you a detailed explanation of each rule that is set up.

Rule description (dlick an underlined value to edit):

Apply this rule after the message arrives
sent anly ko me

and from Bugs Bunny

and on this machine only
play tada,way

and move it to the Deleted Thems Folder

[1Enable rules or all R55 Feeds

You can click the parts that are underlined in blue to change that action or value.
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To create a new rule, click the New Rule button in the Rules and Alerts dialog. The Rules Wizard
will launch.

Rules Wizand [E

Stark from a kemplake or from a blank rule
Step 1 Select a kemplate

Stay Organized

L% Maove messanes From someone bo a Folder

Lf'_-} Move messages with specific words in the subject ko a Folder

L*3 Move messages sent to a distribution lisk to a Folder

X Delete a conversation

Y Flag messages from someone For follow-up

LE‘} Move Microsaoft Office InfoPath forms of a specific bype bo a folder
L™ Move RSS items from a specific RSS Feed ko a Folder

Stay Up to Date
'—‘{'; Display mail from someone in the Mew Tkem Alert Window
il Play asound when I get messages from someone

i! Send an alert ko my mobile device when I get messages from someone

] Check messages when they arrive
I=1 Check messages after sending

Step Z: Edit the rule description {click an underlined walue}

Apply this rule after the message arrives
From people or diskribution lisk
move it to the specified Folder

Example: Move mail from my manager to my High Importance folder

cgak | mMextz | [ Finish

First, choose to start from a template or a blank rule.

Stay Organized
L™ Mave messages from someone ko a Folder
'.E Move messages with specific words in the subject ko a Folder
L' Mave messages sent ko a distribution list ko a Folder
)‘: Delete a conversation
i ‘f Flag messages From someone For Follow-up
n.ﬂa Move Microsoft Office InfoPath Forms of a slﬁﬂcific kvpe o a Folder
"3 Move RSS items from a specific RSS Feed to a Folder
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Then, click the blue underlined items to choose a specific value.

Apply this rule after the message arrives

Example: Flag mail from my manager for follow-up today

If you start from a template, the remaining steps in the wizard will be filled out for you. Simply
confirm your choices by clicking Next, or click Finish at any point.

If you choose to use a blank rule, none of the boxes will be checked when you click Next, so it’s up to you what
conditions you pick. It's the same idea as before: check the conditions in Step 1, and then click the underlined value
in Step 2 to specify your information. In this example, we checked “with specific words in the subject” and then
clicked “specific words” in Step 2. Now we’ll type the words and click Add.

Rules Wizard

Which condition{s) do wou wank o check?
Step 1: Select conditioni s}

[] senk anly ko me

[ where my narme is in the To box

[] marked as importance
[ 7] marked as sensikivity

[ flagged for ackion

[ "] where my name is in the Cc box

[] where my name is in the To or Cc box

[ where my name is nat in the To
[] sent to people or distribution lig
[ with specific words in the body
[ with specific words in the subje
[ with specific words inthe messd | Meeting | | add {%J
[] with specific wards in the recipi

[ ] with specific words in the sendd] * Search list:

[] assigned to category caktegary

Search Text IE [E|

Specify words or phrases to search for in the subject:

Etep 2: Edit the rule descripkion {cli

Apply this rule after the message
Wik it

Remove

Ok Cancel

[ Cancel ] [ < Back J[ Mext = ] [ Finish J
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Once you’ve set the options in this window (you can check as many as you want) and filled out the values, you can
click Next. (If you forget to click an underlined value in step 2, Outlook will force you to fill out the information
before you proceed.) You will then see this window:

Hules Wizard E]

What do you want to do with the message?
Step 1i Select ackion(s)

[] mave it ta the specified Folder e
[ ] assign it ko the cakegory category

[ ] delete it |
[ ] permanently delete it

[] move a copy to the specified Folder

[ ] Forward it to people or distribution list
[ Forward it to people or distribution list as an attachment |
[ ] reply using a specific kemplate
[ flag message For Fallow up at this time

[] tlear the Message Flag |
[] tlear message's categaries
[ ] mark it s importance

Il iprint it ' Fal |
[ play a sound b

[] start application -
[ markit as read

[ rum a scripk
[ stop processing more rules M

Step 2 Edit the rule description {click an underlined valus)

Apply this rule after the message arrives
with Meeting in the subject
prink it

[ Cancel J[ < Back ][ Mext = J[ Firiish

This is where you can tell Outlook what to do when the conditions that you specified in the first part of the wizard
are met. Once you check an item in Step 1 of this box, you may need to click the underlined value in Step 2 to
specify your information. You will also see the conditions that you chose in the previous dialog listed.
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Click Next to see the last set of options.

Rules Wizard X|

Finish rule setup,

Etep 1: Specify a name Far this rule
Meeting

Step 2: Setup rule options

[ JRun this rule now on messages already in “Inbox"
[+] Turn on this rule

Create this ruls orall accounts

Step 3: Review rule description (click an underlined value to editjl

Apply Ehis rule after the message arrives
with Meeting in the subject
prink it

[ Cancel ] [ < Back Mext =

Step 1 in this window is to name your rule; this is the name that will appear in the main Rules and Alerts screen.

In Step 2, you can tell Outlook when to run the rule. The first option tells Outlook to run the rule on messages
already in the folder you're in. The next box is checked by default; this will turn your rule on. The third box, “Create
this rule on all accounts,” is available only if you have multiple e-mail accounts set up through Outlook 2007.

Step 3 gives you a summary of the conditions, actions, and exceptions for the rule you’ve created. Once you're
done, you can click Finish, and you’ll be back to the main Rules and Alerts screen.
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Click Apply and OK to save your changes, or cancel to remove your changes.

In summary, there are three ways to create rules in Outlook:
Create Rule box
The easiest way with only the most frequently used options available.

Rules and Alerts main screen
A few more options and a nicer interface, but still pretty easy to use.

Rules Wizard

More time-consuming but has all options available.
Using the Organize Pane
Another quick way to organize your e-mail is the Organize pane.
Open the Organize Pane by clicking Tools = Organize.

The options will show up in a new pane between your Standard toolbar and your mail folder.

-_'E-._li 7 _Jg' waziags SrEs ﬂ_—\la

& Muowe mennage cFF la L4 ks | | Mrer

=g azaw cRz o adeos, avd Foe —oec adecricd optaos, B Todes o adorsd dhenio,

LH

Staff Party

This pane has three tabs on the left: Using Folders, Using Colors, and Using Views.

Using Folders allows you to move messages that you’ve selected to a folder. You’ll also see options in the top right
hand corner of the window to create a new folder and to open the Rules and Alerts wizard.

e e S e T S e O (LT e I R

& P mrssage s oerd heee ke | b = |f-1:we |
Py Lang ades ————

Pooukm - mdb pads e mrc focprors sdvarced ooaons dd haes 5ad Sarss showe
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The next tab is Using Colors.

# Color messages |from *f.:| Bugs Bunny |i-||Re-:I v|[ Apply Color |

e S it @ Show messages sent only to me in | Blue "'"| [ Turn o0 ]

To wiew or edit vour colaring, and For more advanced options, cick on "Aukoniatic Formatting” above,

First, choose whether you want to look for messages sent from or to a person. Then, type in their e-mail address.
Last, choose a color from the menu. Now, click Apply Color.

Color messages | from ||Eiug_s Eunrry |in | Fed 'v:_| [ Apply Color J

You can also tell Outlook to color messages sent only to you in a particular color; this is a good option if you get a
lot of group messages and want to be able to easily identify the messages that are just for you.

Showw ressages sent only bo me in | Elue 5'95.| [ Turm an ]

Using Views, will let you change how you currently view your mail folder.

Messages with AutoPreview
ﬁ Using Colars Lask Seven Daws
] Lising Colors

Untead Messages in This Folder

2& ...... RS _. Sent Tao

Wigws only change the way vour information looks,

The list of views in this last tab is pretty self-explanatory; you can change your view to all messages, AutoPreview
(which will show the first three lines of your e-mail), messages received in the last seven days, a timeline view,
unread messages, who the message was sent to, what Outlook data file it’s in, or what messages have been
downloaded.

To close the Organizer pane, click X in the upper right hand corner.

Wiges L Cr gl L Lo LewFoeere | Farsand dw,,

@ Mowe ressaqe s ecoed be ke | Sl "
4y Leng Todas

e I oredbvoa wles =rcformrors sdvarced ooaons dd baes 50d Garze sbowe



TIME MANAGEMENT "

Using Search in Outlook
We've covered a lot of ground on how to organize your e-mail using Outlook 2007. But even the best organizational
scheme will only help so much when you have to sort through dozens or hundreds of e-mails. Outlook 2007 uses
the Windows Desktop Search engine to help you find your items.

Installing Instant Search

If the Windows Search Engine is not already installed on your computer, you will need to install it before using the
search feature in Outlook 2007. If the feature hasn’t been installed, you will see this prompt when you open
Outlook:

Microsoft Office Outlook

To enable the Instant Search feature in Outlook, you must
download and install a component for Microsoft Windows.
You must restart Outlook after installing this component.

Dio you wank ko go ko the Microsoft Download Center ko download
Ehis corpanent now?

[ ] oo not show this message again

L Yes J [ Mo J

Click the Yes button to go to the Microsoft Web site to download the required components.

You can also install the component from within Outlook. Simply open any mail folder and click the bar that says
“Click here to enable Instant Search.”

|'—j Inbox |
search Inba 2 T| ¥

| Click here to enable Instant Search o |
Arraniged By Date [ Mewest on 1:.:.;'_ | i
= otder

. _| Bugs Bunny 202212007

| Staff Party
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With either action, you will see the Microsoft Web site open in your default Web browser. Follow the instructions
to download the necessary components.

Using the Instant Search Menu

Once installed, you will find the Instant Search tools under the Tools menu.

Toals

Sends/Receive ]

Instant Search P | 2 Instant Search Ctrl+E
L Address Book..  Ctrl+ Shift+B % Expand the Query Builder  Chrl+ AR+
i Organize S| Search &l Mail Ttems Chrl+ Al 2
Lﬁ. Rules and Alerts.., +  Search Desktop Chrl+ A+ K

hailbiox Cleanup.., B Indexing Status..,
5] Empty "Deleted Fems” Folder L Search Options..,

Forms ] Advarniced Find... Ctrl+ Shift+F

Macro L Related Messages..,

Account Settings... Messages from Sender..

Trust Center...
Customize..,

Dptions..,

Here’s an overview of each option.

Instant Search Perform a quick search.

Expand the Query Builder Perform a detailed search.

Search All Mail Items Search in all mail items.

Sear ch Desktop Search outside Outlook.

Indexing Status See what items search has catalogued.

Sear ch Options Set search options.

Advanced Find Search using the older style dialog.

Related M essages Find messages related to the currently selected one.

M essages from Sender Find other messages from this sender.
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Performing an Instant Search

To perform an instant search, type what you’re looking for in the Instant Search box.

= Inhex {Seprch Results)

Trpsezroonirng dnz 0 o~ keailll: =,

| | = |" oA
Anr g1 e Dot U= nirct ..
2 Ll ek
-] Imaqs Munng [ [TWIYrS

Saza bzl g ‘f
(=4 Samb Hakels L T

FIestir 3 | 1dav

IR FA N Al e sy s

Sales Mesting

a3 Boresy [ealsofliar o s oo |

St Py AL 200 2R L

Tay Sanfb oo Lo

cvemsinge | E8]%ales Peee s atatle - 7R

Hi = nn
He e ars th2 8 deztorzoronos’zrest g
1 1anks

L 58

As you type, results matching your query will appear in the list and matching search terms will be highlighted in
yellow. You can work with the found items as you would any other item in your folders.

Once you've found what you’re looking for, click the X to clear the search. You can also click
another folder in the Navigation pane; the search results will clear automatically.

Note that you can also click the link at the bottom of the results to search in all mail folders, not just the current

folder.

"3 Inbox (Search Results)

imeeting

Il -

Arranged By: Date

| Mewest on to \—r)—l—
C

=l Last Week

lear Search

=1 Bugs Bunny
Sales Meeting

[=4 Sarah Hartis
heeting Friday

Thu 222
1]

Thu 2722

CHat o A Wheat e Weere searching far?

Try searching again in &l Mail Items.l
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Using the Query Builder

For more advanced searches, use the Query Builder.

Click Tools - Instant Search - Expand the Query Builder.

Mailbiax Cleanup.., Indexing Status...

Inols |

SendsReceive ]

Instant Search k| P Instant Search Ctrl+E
[ Address Book.,  Ctrl+Shift+B “ Expand the Query Builder  Chel+ AL+
iy Organize 2] search &l Mail Ttems : I+ At 4,
1 Rules and Alerts.., 27 search Desktop Chrl+ &lt+ K

p-

@ Empty "Dieleted Items" Folder gﬁ Search Ciptions...

Farms 3 Advanced Find... CErl+ Shift+F

Macro L4 Belated hessages..,

Account Settings... Messages from Sendef..,

Trust Center...
Customize...

Optians..,

You can also click the double arrows next to the search box.

I Inbox |

[ 2~ %
Jitangeg By Hat [Hensstionton HExpandthe iguery Builder

The search box will then expand to a series of fields.

3 Inbox

search Inbox el
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Simply type your criteria and watch the results appear!

| Inbox (Search Rasults) sales Meeting
!"':"“[t_'_”_gs_ HIRRYY 5L £t eRtng |x|= s Bugs Bunny [velsoft@macdom ail.com]
ﬁ*’-.:ﬂf . v-r- _l|i_-..|_;|g_s~|:-,un|-}r . oot Mon 1452007 10:06 LA
Bt_h:ig = | To welsafbmmedonzil.zcm
Supper v .|" g L Message | B sales resentation.ppt |2 ME]
o |
[1i Gz

St
e i By Lidte s 5 Hera ac tha clides fortamorraw: s measting,
= Last teek Thanks,
= 3ngs Fune Thu 2
i jalgs Eﬂeetlaq G f@ Bugs

LA B L R FRTE VOL WeSFe S2aYomng 007

Ty szarching aga min All Mail Zterrs,

Like the basic search, you can change your search to include all mail items, or you can use the X to clear your
search.
About Search Folders

A standard Outlook 2007 account includes three search folders: Categorized Mail, Large Mail, and Unread Mail.
These folders are just like the Category Search Folders we looked at earlier.

To open a search folder, just click it as you would any other mail folder.

You can see your search folders in the Navigation Pane. (If you can’t see the list of search folders, click the plus sign
next to Search Folders so that the list is expanded.)

Mail « ||L2 Large Mail
Favorite Folders % M| search Large Mall 0 vl o
Drag Your Favarite Folders K
b R L R Arranged Ey: Lize Largest on top | o
Mail Folders -l
i [=] Huge (1-5MB)
2] All Mail tems v | p——— s
: — | -l Bugs Bunny 242272007
= ‘@ Intermediate Level | SalesMeeting Bt
H (5] Deleted ems ;
= (=4 Bugs Bunny 2222007
L7| Drafts [1] - @
34 Inbox ales Mesting

L @ Junk E-mail [1]
Quthox
() RSS Feeds
L3 Sent Iems
5.0 search Folders
L Categarized Maii
:L;i'.‘l Large Mail
L Urread Mail




55 B
TIME MANAGEMENT "
Keep in mind that your messages aren’t actually stored in these folders. When you click one of these folders,
Outlook looks at its criteria, and then searches through all your folders to find messages that match those criteria. It
then displays the messages that match in the message pane like it would for any other folder. You can then work
with those messages like you would any other; for example, you can delete, edit, reply to, or move them.

So, if you clicked on the search folder labeled Categorized Mail, all the messages that you have assigned categories
to will appear in the message list. The other folders work the same; the Large Mail folder will show all your
messages over 100 Kb, and the Unread Mail folder will show you all the mail you haven’t read yet. (Those three
search folders are created by Outlook by default.)

If a search folder is in italics it means it hasn’t been updated recently. Once you click the folder, Outlook will update
the search and remove the italics from the folder’s name.

Customizing Search Folders
You can customize any Category Search Folder, even the ones that Outlook has created.

Right-click one of the folders and click Customize this Search Folder.

=RNs) Search Folders

L0 Andy s L

L0 Certegar L Qpen

LE Large M Cpen in Mew Window
o Urread

g.g Customize this Search Foldet...
—

Delete "Andy &nderson [andy@plum%.."

ale Perames "nde Andersan fande@alombk 0

When you do that, this window will appear:

Customize “Andy Anderson (andy@plumbing.... E”Z|

§ Mame: | Andy Anderson {andy@plumbing, com) |
Select "Criteria" to change what ikems this Search
Folder conkains, e

Mail From these Folders will be inchided in this Search Folder:

Intermediate Level | Browse...

[ 84 ] [ Cancel ]

The first option in this window lets you type in this box to change the name of the search folder. The Criteria button
will bring up a small window with just the options you need. (For example, in the box above, clicking on Criteria
brings up a box prompting you to enter the name of the person.)

The Browse button lets you pick what folders this query should search. This is really useful if you want the query to
search only a few folders in Outlook. Once you click the OK button, your changes will be saved.
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You can also customize other aspects of a search folder by right-clicking on it. In this menu, you'll see the same set
of options that other mail folders in Outlook have, including deleting or renaming the folder. Remember that
deleting the search folder doesn’t delete the messages shown in it.

Dpen
Openine Mew Wind o
Customize this Search Folder..,

Delete "Andy Anderson [andy@plumb,..”
Bename "Andy Anderson [andyi@plurmb...”..

Mewr Search Folder..,
Add to Favorite Folders
Mark All as Read

Process All Marked Headers

% Properties

Using Search Folders

Here are some examples of search folders and how you can use them every day:
= Use the criteria From Specific People and specify your boss’s e-mail address so you can easily view all the e-

mail he or she has sent you.

= Use the Important Mail criteria to see all the messages sent to you marked as urgent.

= Use the Mail with Specific Words criteria and specify the phrase “XYZ Company” to keep track of

correspondence relating to that account.

= Use the Mail Sent Directly to Me criteria and specify the Inbox folder to help you sort through the mountain

of e-mail that accumulated during your vacation.

There are lots of ways that you can use search folders to find key e-mail messages quickly and easily. The best way
to learn what works for you is to set up different search folders and play around with the options!

About Favorite Folders

Another great Outlook feature is favorite folders. Favorite folders are just a list of commonly used folders. The list is
similar to the other folders in the Navigation pane in that each folder will show the unread count. You can click any
of these folders to see its contents (for mail or item folders) or to run a query (if the folder is a search folder).

To add a folder to your Favorite Folders list, simply drag
the folder into it that section of the Navigation Pane.

You can move items around in the favorite folders list by dragging
them or by right-clicking on them and choosing Move Up or Move
clicking will also give you the option to remove the folder from the
of the typical folder options like renaming, deleting, copying, or
folder. Default folders like Inbox, and Sent Items cannot be
renamed, or moved.

Mail . | anddrop
Favaorite Folders B
2z Junk E-n '“!" and dropping
Mail Folders x| Down.Right-
: ) list, or use any
L] AN Mail e ms * | moving the
= 5 Intermediate Level deleted,

H &) Deleted Ttems
(7| Drafts [1]
[ Inbox

Lei

L Outbox

[ nce Eand-
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About Shortcut Groups

Shortcut groups are a new feature in Outlook 2007. The feature is similar to the favorite folders list, only it’s for
non-mail folders. Let’s look at an example.

Here, we have several different contacts. By default, all these contacts are stored in a group called My Contacts.

Contacts

L

Fﬁ All Contact tems

My Contacts
85 Contacts
[ Acme Company
|85 Mason Catering
|85 smith Plumbing
|85 Personal

Now we’re going to add a new group called Suppliers.

Click the Add New Group link.

*

Contacts

L

Fj All Contact Ttems

My Contacts
55 Contacts
{5 Acme Company
|55 Mason Catering
%5 Smith Flumbing
%5 Personal

b

Current ¥iew

%) Business Cards
Address Cards
Cretailed Address Cards
Phaone List

By Category

By Campary

By Location

Cgtlook Data Files

Add Mew Grou
Customize Curé }t&-"iew...

elolclcleole)

b
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You will then see a small text box appear.

Type the name of your group and press Enter.

Contacts %

Fﬁ All Contact tems hd
My Contacts 2
[FE e ontacts

[ Acme Company
|85 Mason Catering
|85 smith Plumbing
5 Personal

| Current View %
Now, drag and drop Contacts into the group.

Contacts %
;Cﬁ All Contact Ttems -
My Contacts 2
|85 Contacts
|85 Mason Catering
|85 Smith Plumhbing
|85 Personal
Suppliers & | Acme C Umﬂtg iy
Current Yiew ~

You can right-click the name of the group to customize it.

Contacts i
Fj All Contact Ite ms -
My Contacts -3
|85 Contacts

|52 Mason Catering

&= Persanal

Suppliers :q« ) =

D Bename Graup

Femowve Group

Current Yiewr Mew Group

{3} Business Car
() Address Carg

() Detailed Add
{:} Phone List & Move Drgwr [0 List

Arrange By Mame

@ Mowve Upin List
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Getting Rid of the Junk

We've already learned that there are many tools to help us deal with the volume of messages that we receive. But
what about the messages we don’t want? In this lesson, we’ll discuss the security tools that will help protect you
from unwanted mail.

Using the Junk E-Mail Filter

One not-so-great thing that happens after you’ve been using e-mail for a while is junk mail. Like that stack of flyers
and “great offers” you find in your postal mailbox, junk e-mail is usually advertisements or, worse, scams.

Outlook 2007 has some features that can help you manage that junk mail. The first step you should take is to tell
Outlook how strict it should be when it looks at your incoming e-mail.

To access these options, click Tools = Options, and then click the Junk E-mail button in the
Preferences tab.

The Junk E-mail Options window will appear.

Junk E-mail Options

Options |SaFe Senders | Safe Recipients || Blocked Senders | International |

E—ql Cutlook can move messages that appear bo be junk e-mail into a special
AP Junk E-mail Folder,

Chonse the level af junk e-mail proteckion you want:

{7 Mo Aukomatic Filkering, Mail from blocked senders is still moved ta the
Junk, E-mail Folder,

(&) Lowe: Move the most obvious junk e-mail to the Junk E-mail Folder.

{7 High: Most junk e-mail is caught, but some regular mail may be caught
as well, Theck wour Junk E-mail Folder often,

{7y 5afe Lisks Only: Only mail from people or domains on your Safe
Senders Liskt or Safe Recipients List will be delivered to wour Inbox,

[ ]Permanently delete suspected junk e-mail instead of maving it to the
Junk E-mail folder

Disable links and other functionality in phishing messages.,
(recammended)

P
iciols domaln names in e-mall addresses.,

When sending e-mail, Postmark the message to help e-mail clients
distinguish regular e-mail Fram junk e-rail

For now, we'll focus on the Options tab; we’ll discuss the other tabs in a moment. By default, Outlook chooses the
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“Low” setting for you: this moves e-mail that’s obviously junk to the junk e-mail folder. If you choose the High level,
you risk some of your wanted e-mail going to the junk e-mail folder, but you probably won’t get any spam in your
Inbox. There’s also the “Safe Lists Only” option, which means Outlook will put all e-mail in the junk e-mail folder,
except for people that are on your safe list. (We’ll talk about safe lists in a moment.) You can also turn the junk e-
mail filter off using the first option in the list.

There’s also a checkbox at the bottom that tells Outlook to delete anything it thinks is junk e-mail. We don’t
recommended checking this because Outlook isn’t perfect; there are times it will mark an e-mail as junk when it’s
really something you want to read. If you have this option turned on, the e-mail will just be deleted and you won't
have the option to retrieve it from the junk mail folder.

The next two checkboxes deal with the phishing filter, which we’ll discuss in a moment. The last checkbox lets
Outlook add a mark to outgoing messages that will help prevent them from being marked as junk.

Once you’ve set your options, click OK to apply them. Now, if Outlook downloads a message that it thinks is junk,
you will see this notification:

Microsoft Office Outlook

utlook has downloaded a message that appears ko be Junk
E-mail. This message was automatically mowved to the Junk.
E-mail Folder.

You should check the Junk E-mail Folder regularly bo ensure that
wol donok miss e-mail that you wank o receive,

[ ]Please do not show e this dialog again

[ Cpen Junk, E-mail Folder ] [ Junk E-mail Sptions., .. ] [ Close ]

You can choose to open your junk e-mail folder, see junk e-mail options, or close the dialog. Note that opening the
junk e-mail folder is like opening any folder; just click it to display its contents.

Wiail 4 |-@ lunk E-mail Fie: VIEAGRA
Fomnrbe Fokders # A Ay LR i h . H
I' ;| L Li ol ovands atiega aE ooeetti tifa, o]
180T e R TTIRT] -
[k e e v || s Frhass shmr i shisd =Bt sias ik urchans e e s n i e g
He e ko,
Wl il E I T SO Hawme. ot .
5 EralLE s ! Bt lre =20l T ARl ndssdoe 08 ranostc;
ARt Ermy - Tyt Caliags e peted oo soal ke
4 |:_';' Hamp e lew l—l Hhkt RRTU T TR TR N TLR R TR |
O vl b [heeke i Sl o IRkl oy
|4 Prate (TR L L T
L nkea 101 (S
L@ Junk C-rall 4 k
= )
) ':"_tfx" (T T A LR TR I I R W B 1 [T P R A A [T TS TR | 1)
(7 RZs =ends
K % -_-_. Al
Lo l2 mgz g7 w2 L oreelleen . o gy oLy Lbe popueluz, Lozlinl Loodos
—.ralan snd walkl T Ak sy, The rRlodnnr ol 'coRT A s <Rl ApERn.
Fand

The green number next to the folder name indicates the number of new items in the folder. Also note the message
bar in the preview pane that states what functionality was disabled in the message. If you move the message to the
Inbox, the functionality will be restored.
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You can right-click any message and choose the Junk E-Mail menu to see options for dealing with the message.
Outlook 2007 will learn from its mistakes if you correct it, so you should take the time to mark a message as Not
Junk if that applies.

Arranged By Dat= Mewest on top ‘ o
= ouder
i Cande Noriega W
C penIEACRA R k.
@ Print
i Reply
Q Reply to Al
;% Forward
Faolow Up k
Categorize k

h":;.

mMa‘k as Unread

Find all ¥
[ﬁ- Create Rule..

dunk E-mail RY} £  Add Sender to Blocked Serders List
'}( Delete Add Senderto Safe Senders List
LS Move ta Folder... Add Sender's Diorain [@erample. com] to Safe Senders List

Message Cptians... Add Recipient to fafe Recipients Lis:

LAt Serdto OneMaote Mark as Hotlunk..

lunk E-mail Options...

sl [
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Arranged By Date

f Mewest on top

Note that if you right-click a message that is not in the junk e-mail folder, the options available will be slightly
different.

,|‘

= onder
'- 5 s o
i Bugs Bunny
_ stoftparty _
=1 Bugs Bunny el
Sales Meeting @ Print
1 sarah Harris 4 Reply
Sample Logo ﬂ
— b Reply to All
-1 sarah Harris 5 R 3
Meeting Friday | e Forward
=4 sarah Harris Fallow Up >
Polly's Report
pay Categorize 3
=1 Microsoft -
Canadian Techiet i Mark as Upnread
Firnd All [
lﬁ- Create Rule..,
Junk E-mail R\: IR
X Delete
L3 Move to Folder...
2]  Message Options...
@ Send to Onefote _]

Add Sender ta Elocked Senders List
add Sender to Safe Senders List
add sender's Domain [@example.com) to Safe Senders List

Add Recipient to Safe Recipients List
Mark as Mot lunk...

Jurk E-mail Options..,
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About the Phishing Filter

Phishing is a new trend amongst scammers. Messages that do the “phishing” appear to be legitimate but are
actually designed to steal personal information. For example, you may receive a message from your bank stating
you need to confirm your personal information. However, the link in the message might actually take you to a fake
Web site that looks real. If you were to enter your personal information as requested, someone else could use that
information to get into your real bank account.

The best protection from phishing scams is to be aware. If you receive a message asking for any type of personal
information, call the company directly. Most companies will state in their fine print that you will never be
contacted for any personal information. Outlook 2007’s phishing filter disables suspicious links. By default, this
filter is enabled. You can toggle it on or off via the Junk E-Mail Options dialog.

Junk E-mail Options

Options |Safe Senders || Safe Recipients | Blocked Senders || International |

E'_d Ouklook can move messages that appear bo be junk e-mail inko a special
Junk, E-mail falder,

Choose the level af junk e-mail protection you want:

{7 No Aukomatic Filkering, Mail from blocked senders is still moved ta the
Junk E-mail folder.

&) Low: Move the most obvious jurk e-mail to the Junk E-mail Folder,

i Hight Mast junk e-mail is caught, buk same reqular mail may be caught
as well, Check your Junk E-mail folder often,

) Safe Lists Only: Only mail from people or domains on your Safe
Senders Lisk or Safe Recipients List will be delivered to waur Inbos,

[ ]Permanently delete suspected junk e-mail instead of moving it to the
Junk, E-mail Folder

Lisable links and okher functionality in phishing messages.,
frecommended)

shspicious domain names in e-mall addresses,

When sending e-mail, Postmark the message to help e-mail cients
distinguish regular e-mail from junk e-mail

[ Ok ][ Cancel ] Applh

If your organization uses Microsoft Exchange Server 2007, you can also choose to have Outlook warn you about
suspicious domain names.



TIME MANAGEMENT

If the phishing filter is turned on, you will see a warning in the preview pane when links have been disabled. In this
case, images have been prevented from downloading (a security feature) and the message has been marked as a
possible phishing message.

- Inbox el # = ¥ | Canadian TechNet Flash: Special Events
Ararges Dy Cake Hzwest o~ top | “| Edition - Launch 2007
= J— I".'1ILI defl Mlc.mbh LCrluu'I.r-ll:lLurt..rnluu:.u Lmurn

m

ﬁﬂhﬂ's* !
zent Thu 10.‘19-@..5 ?'-1" F“h‘
T clmifuels oft.com

w| P.ght-dck. beaba bo donboaz pretobar o hal s oo
pochure o W Tree -l

Beerus Sthibing TeohNal Flaaima [ez rewslelle padbed wi

soowored Ty lecthMst subsmce now, ff yvao e roc alrea:

Be z part of the higgest Microsoft Laur

Reejlsta- nowe for thie 2077 Wrosoft - 3amh Beenit

Elght=rlrk =are b d=wronad poelores, Tocbelp gt o
dovnoxd o-Fispi curx Torm the I-ternct,
Fradu fur 3 ew Jay

To enable any functionality inside the e-mail, click the warning message. In this example, we have the option to
download the pictures in the message, change the automatic download settings, and to enable links and other

functionality (disabled by the phishing filter). There are also options for the blocked and safe senders’ lists, which
we will discuss in a moment.

Thix =gt b o phithing wessags < ndis potenzsly unesfe_inks snd:obiverfu g dimne fy = oes bean disablee; Cidt ~ere 2o spabis func
Thic Rerrie doiv=lond = diirer Tohe piarstect vz —pros &y Dulklo gl ==svarted & .‘! T

gealignob woormescad|

From Microsaft [y oo soft® newslcttors mbores ok oo 3
Tae Wi e £ 0L, i Crange dutemzs ¢ Download Setbings...

i Enaae Links and ct=ar tund cnallt (Aot recommerdedi

Euhject Canacian Techhiet Fas= Spessl Ciends Cd2ior - Launck 2007

AcdForccn te Zafe Zende s LIsT

I1n:nlrF“l: Fe Mr:]rnn'!n _ . Acdthe Dorain B amvwsletersricosoft.com oo Safe Senders List
W' stors the day with Eroas®ast cre or evervoow of the now solutions s

Lirnss Winnlenwe Wola 1w 3007 Blicioea I ATas s aclemn =0l Ferbanms Secva 2077 - an 1

If you choose to enable the functionality, the message bar will go away and you will be able to work with the
message as normal.
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About Automatic Downloads

One trick that spammers have recently employed is to include a small picture in their messages. If the picture is
downloaded, it means the e-mail address is active. Spammers can then use this information to determine the best
targets for spam.

By default, Outlook does not download pictures from most addresses. If this happens, you will see a message bar
indicating this and you will see text where the images are supposed to be.

Canadian TechNet Flash: Special Events Edition - Launch 2007

bicrosoft [Microsoft@newsletters.microsoft.com]

Click here to download pictures, To help protect your privacy, Outlook prevented automatic download of
some pictures in this message,

Sent Thu 100193/2006 742 P

Toe kim@velsaft.com

Sign up for other newslette

Right-click here to download pictures, To help protect vour privacy, Outlook preventad automatic download ¢
picture fram the Internet,

Events Edition TechNet Flash-afree newsletter packed with pradictable information about IT Pro

events sponsored by TechMet, Subscribe now, if vou're not already receiving the Flash,

To change the settings, right-click the message bar.

Canacdian TechMet Flash: Special Events Edition - Launch 2007

Microsoft [Microsoft@newslettersmicrosoft.com]

Click here to downioad pictures. To help protectyour privany, Outlook p
s pictures inthis message. . Download Pickures
Sent Thu 1071972006 742 PM
To: kirm@vyelsoft, conm

rpevented automatic downlosd-of

Change &utomatic Download Setings..,

Add Sender to Safe Senders List

Add the Domain @newsletters.microsoft.com to Safe Senders List

Right-click. here to download pictures, To help protect vour privacy, Qutlook prevented automatic download ¢
picture from the Internet,

The first option will allow you to download the pictures. The second option will open the Automatic Download
section of the Trust Center, where you can choose when images will be downloaded and when you will need to
confirm download.

The other options will let you add the sender or the domain to the Safe Senders list, so all images in messages sent
from addresses in this list will be downloaded automatically.
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Applying Blocked and Safe Senders Lists

Blocked and safe senders lists are a way of telling Outlook 2007 which addresses you trust and which addresses you
don’t.

To modify these lists, click the Tools & Options 2 and then click the Junk E-mail button to open
the Junk E-mail Options dialog.

Now, click the Safe Senders tab.

Junk E-mail Options

| Options | Safe Senders | Safe Recipients | Blocked Senders | International |

—| E-mail from addresses or domain narmes on your Safe Senders List will
&J never be treated as junk e-mail,

add.. |

REmove

[ Import From File, .. J

[ Expart ta File, .. J

Also trusk e-mail Fram my Contacts
[]Automatically add people I e-mail to the Safe Senders List

Adding someone to this list means e-mail will never be treated as junk, nor will Automatic Download or phishing
settings apply.

Click the Add button to add senders to the list. When the Add address or domain dialog box
appears, you can add specific addresses, such as jim@acme.com, or just a domain, like
acme.com.

In the first instance, only jim@acme.com would be treated as a safe sender; in the second instance, anyone sending
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a message from an address ending in @acme.com will be considered safe. You can also use the bottom options to
make your contacts safe senders and add people you send e-mail to, to the safe senders list.

The Blocked Senders tab looks similar to the Safe Senders tab. However, addresses and domains in this list will
always be marked as junk e-mail, even if the junk filter is turned off. Like the Safe Senders tab, click the Add button
to add blocked senders. You can add specific addresses, such as jim@acme.com, or just a domain, like acme.com.

Junk E-mail Options

| Options || Safe Senders | Safe Recipients | Blocked Senders | International |

_ E-mail from addresses or domain names on your Blocked Senders Lisk will
always be treated as junk e-mail,

| add. |

REMOVE

[ Import From File, .. ]

[ Expart ta File, .. J

Once you’re done entering your settings, click OK to apply them.
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Summary
In order to be effective at work, it is important to keep your work area and your electronic files organized.
Remember that file retrieval systems work best when like items are grouped together, there’s a place for
everything and everything is in its place, and everything is labeled clearly. Outlook 2007 lets you organize items by
color, through custom folders, e-mail rules, and Category Search Folders. And if you do happen to misplace
something, the Search function is always available to track down the missing item.



